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Introduction 

Welcome 

  
WinNCS is the new configuration and diagnostic system for system 
components. At present the following systems may be configured by 
means of WinNCS: 
 

 H1 / TCP/IP (Ethernet-CP, Ethernet coupler) 
Profibus-DP (creates 2bf file) 
CPUs for STEP 5 from Siemens (creates DB1) 
 

 WinNCS is the acronym for Windows Network Communication System. 
This program is the successor to NCS for MS-DOS.  
The parameterization software runs under Windows 9x/2000/NT4. 
Configuration parameters that were created for H1 or for TCP/IP by 
means of NCS for MS-DOS can be imported into WinNCS.  
 
We hope you will enjoy working with WinNCS! 
 

Changes to former versions 

  
The recent documentation describes the projecting software WinNCS 
starting with version 3.12. 
Versions 3.12. and higher contain the following improvements: 
 
• The context menu changes depending on the mouse position. 
• Transfer functions are now online functions. 
• Status/SteuernVar has been adapted from WinBB. 
• Now, only one VPR-file is created that is extracted at WinNCS start 

and zipped again at closing.  
• The GSD-file now supports the "special identifier format" for Profibus. 
• Access to Ethernet coupler (search function with automatic setup, 

online engineering, firmware update) 
• The online access to the Ethernet-CP has been extended by search 

functions with automatic setup and firmware update. 
• Access control for TCP/IP-CPs happens via IP lists. 
• The demo version of WinNCS allows to export one DB1. 
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Getting started 

Scope of delivery 

  
The WinNCS program is delivered with the following components: 
 

 WinNCS  
BDE (Borland Database Engine)  
H1 Driver  
Manual 
 

 
System requirements 

  
The following hardware components are required for WinNCS: 
 

 Pentium-based IBM compatible PC 
A minimum of 8MB RAM (we recommend 64MB) 
30MB of unused disk space on the hard disk  
Super-VGA video adapter with a minimum resolution of 800x600 
pixels 
Windows 9x, Windows 2000 or Windows NT operating system  
An optional printer 
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WinNCS installation  

 

 WinNCS.exe 

 
WinNCS is installed by means of a setup program. We strongly advise 
that you terminate all other Windows programs before executing the setup 
program. Insert the CD and execute Setup.exe. 
The following procedure is performed: 

 The setup assistant is initialized. Select a language and confirm your 
selection with [OK]. 

 The "Welcome" window is displayed. This contains information on the 
installation and on the copyright – confirm by clicking [Next] and indicate 
your agreement with the licensing conditions by means of  [Yes].
 

 Enter your name and the name of your company into User information.  
 Select the WinNCS directory as Path. 
 All files of WinNCS and of the BDE (Borland Database Engine) are copied 

to your PC. 
 
The installation is finished as soon as the message "Setup completed" 
appears. 
 

Directory structure of WinNCS 

  
Setup defines WinNCS directory during installation. At this time the 
following directory structure is created on your hard disk. 
 
GSD The directory for the current Profibus GSD-files: 

Every manufacturer supplies the characteristics of their slave 
in the form of a GSD-file which you must use to configure 
your profibus slave. 
If you have later versions of GSD-files or GSD-files from 
other vendors you must please copy these into this directory.
 

Ws295sdk Ws295sdk contains an installation utility for Win-Sock2 
functions required for Win95. These functions are a required 
by WinNCS for TCP/IP communications. 
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Starting the program 

 
 

 
The simplest manner to start WinNCS is by selecting WinNCS in the start 
menu. You can also start the program by executing the WinNCS.EXE file. 
The program displays the start window containing information on the 
version.  

  
To ensure that your work with WinNCS is optimized you should set the font 
to small fonts and the resolution to "800x600" in the control panel.  
 

 
 
Closing the program 

 
 

 
WinNCS is terminated from the main menu. When the program is 
terminated, a file with the name WinNCS.ini is saved to the disk. 
WinNCS.ini contains all the configuration settings that you have entered 
into the program.  
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Program registration 

 
Outline 

 
The registration has the following approach: 
 

 

                  

Licence Key

www.key-reg.com

Sales Partner WinNCS

Hardware ID

WinNCS

OK

Email
Activation Key

 
 

Licence key You receive the licence key from your sales partner. 
 

Hardware ID Via ? > Registration the registering dialogue opens. 
 

 

 
 

 The dialog box shows your Hardware ID and a link to the website where 
your activation key is calculated. 
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Calculate 
activation key  

Click on the link to http://www.key-reg.com. The following website opens. 

 

 
  
Customer data Please insert the required data: 
Name Customer name 
Company Customer site 
Email The activation key will be sent to this address. 
Hardware ID The ID shown in WinNCS. 
Licence Key You've received the licence key from your sales partner. 
  
 After clicking onto [Submit], an Email with the activation key is send to the 

given Email address.  
 

Activate Licence  To activate your license, please type the activation key into your software 
under "Registration" and confirm with [OK]. 
 

 Now the Software is registered. 
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WinNCS environment 

Overview 

 
Main window 

 
WinNCS starts, the main window is displayed. 

 
As soon as you create a new project or open an existing one via File > 

Create/open project  , additionally the dialog windows „Network“ and 
"Parameter" are shown. 
 

"Network" and 
"Parameter" 
window 
 

   
 
The „Network“ window gives you a fast overview over the complete project 
for it is possible to engineer several systems at one time. These are saved 
as one project file in the database.  
A tree structure lists networks with subordinated stations and concerning 
connection jobs.  
The parameters concerning to the network, the station and connection job 
are shown and altered in the "Parameter" window. 
 

Help system WinNCS provides several help functions. Detailed help is to find via ? in 
the main menu. Context related help to a certain dialog window appears 
when you strike the function key at activated window. 
 

Context menu WinNCS offers a context menu that is activated via the right mouse button. 
This menu gives you access to functions that are only available at this 
mouse position.  
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Main window 

 
General 

 
WinNCS starts, the main window is displayed. This contains the menu bar 
and the tool bar that are allocated to the most important functions. 
 

 
Menu bar 
 
Main functions 

 
The menu bar is located at the upper border of the main window. The 
following table lists the commands available from the menu: 
 

File Create/open a project, Save, Save As, Close, Printer settings, Preview, 
Print, Close 
 

Edit Symbols (Symbol manager only available for "Ethernet functions") 
 

Online Online functions 
 

Extras Center windows, Dockable windows, German, English, Ethernet, 
System 200V, Profibus 
 

Tools Include and start external programs 
 

? Help topics, About 
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Menu items 

 
Menu items res. 
buttons 

 
This table describes the menu items with according button and function. 
The most important functions can be called via buttons.  
 

File > Create/open a 
project 

 

Create a new project or open an existing project. A file selection window is 
displayed where the respective project file can be selected. WinNCS 
project files have an extension of *.vpr. The file names of the four most 
recent projects are included in the file menu and these can be opened 
directly from there. 
 

File > Save 

 

The current state of the project is saved. This function is executed 
automatically for the menu items close and Exit. 
 

File >  
Save as 
 

The project file can be saved with another name in another directory. 

File > Close 

 

The project that is currently open is saved. The "network" window and the 
database window are closed 
 

File > Print options 
 

The print options provide access to certain settings for the type and layout 
of the printout. The print options determine both, the layout of the printed 
page as well as the layout on screen. 
 

File > Page view 

 
 

Depending on the selected print options the preview returns a detailed 
output or a list of the configured records. 

File > Print 

 

The parameter settings for the LAN, the stations or links are displayed. 
Depending on the print options a detailed display or a list of configured 
records is printed. Before the printout is started, the standard printer menu 
is displayed where you can enter additional printer options. Here you can 
select a certain printer and specify the number of copies. Any other 
settings are ignored. 
 

File > Exit 
 

All configuration settings for the program, i.e. the window position and 
size, are saved. Subsequently all the windows are closed and the 
program is terminated. 
 

Edit > Symbolism 

 

The symbol manager is only available from the "Ethernet" option. It is 
used to assign symbolic names to absolute addresses. Addresses may 
consist of Ethernet addresses or of IP addresses. 
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Online >  
Online functions 

 
 

Activate res. deactivate the online functions for "Ethernet" and "Profibus". 
 
 

Extras > 
Window centering 
 

This command centers the program windows displayed on screen. 

Extras > 
Docking windows 
 

All program windows may be docked together. 

Extras > German  
or  
Extras > English  

Here you select the required language without terminating the program. At 
the moment you can select between German and English. 

Extras > Ethernet 

 

Selects the "Ethernet" functionality. 
This setting is used to configure H1- or TCP/IP-modules. When you exit 
from the menu, the tool bar in the network window of the "Ethernet" 
functionality is changed accordingly. You can now position H1 or TCP/IP 
stations in the network window and configure the respective connections. 
 

Extras > Profibus 

 

Selects the "Profibus" functionality. 
This option must be selected when you wish to configure a Profibus 
network. When you exit from the menu, the tool bar in the network window 
of the "Profibus" functionality is changed accordingly. You can now 
position the Profibus-DP master stations in the network window and 
assign Profibus slave modules with the respective peripherals. 
 

Extras > 
System 200V  

 

Select the "System 200V" functionality. 
These functions must be selected when you wish to configure a CPU for 
STEP5 from Siemens and the respective modules. 
As soon as you have selected this function, the tool bar in the "network 
window is changed. Now you may configure the CPUs and modules 
shown above. For a CPU, WinNCS creates an image of DB1 in 
accordance with your configuration which you can export as s5d-file. 
 
 

Tools > Tools ... 

 

In “Tools” you can start external programs that you have previously added 
to the list of tools. 



Manual VIPA WinNCS WinNCS environment 

HB 91E - Rev. 04/03  11 

Saving a project 

 
Database 

 
The database integrated into WinNCS is based on the Paradox format. All 
configuration and setup data for functional groups, stations, modules and 
connections are saved in a database. 
 

Project If a project is open, all project files (incl. database) are in the directory 
PROJECT. 
When you close the project, the complete folder PROJECT is saved in the 
file PROJECT.VPR and copied back again in the folder PROJECT at the 
next opening. 
 

Printer output 

 
General 

 
The printout serves the documentation and -in case- the error search of 
your project engineering. Depending on the settings in the print options, 
you may print lists, detail views or labels for the complete project or a 
network.  
 

Print labels For printing labels, you have to select Labels in the print options. When 
you reach the module level of a network, Print starts the printing of all 
labels for these modules.  
 

Page view 

 

For a preview of the print output you may choose the Page view. This 
shows the print pages on screen. 
 
 

File > Print 

 

The menu option File > Print or via the according button calls the 
standard dialog window for printing. In this window you select the printer 
and choose the number of copies. Adjusting page areas is not possible.  
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File > Print options Via the print options you may choose several options for type and layout 
of the print output. The print options concern to the output on paper and in 
part to the page view at the screen. Selecting File > Print options, the 
according dialog window appears. 
 

 

 
 
 

Total network If this box is activated, a print command starts the printing of the complete 
project engineering. This box has no influence on page view. 
 

Detail view You may choose wether a printout is detailed or in form of a list. If you 
select Detail, the output (printer or monitor) contains every element on an 
individual page.  
 

Labels To print labels, mark a module in the "Network" window, tick the control 
box Labels and ok. The labels for all modules on the same hierarchic level 
are printed. The page view allows you to control the labels on the screen 
before printout.  
Printing labels sets the control boxes total network and Detail view without 
function. 
 

Project, Name, 
Company 

Entries in these lines are printed in the bottom line of the printout.  
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Page view 

 
File > Page view 

 

 
You reach the page view via File > Page view or via the button. The page 
view allows you to control your data in form of a list or detailed or save it 
as report. The page view shows all elements of one hierarchic level as 
list or detailed.  
The viewing type depends on the print option settings (see there).  
The page view offers you the following buttons: 
 

Close current Page view

Open a report 

Save a report

Print current report 

Open Printer options window

Last page

Next page

Previous page

First page

Page width view 

View  1:1 (100%)

Optimize view 
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Include programs 

 
Tools 

  

 
Via Tools you have access to external programs that are administrated in 
form of a list in the tool options.  
After the first installation of WinNCS, the program list is empty.  
To add an external program, open the window for tool options via Tools > 
Tools. 
 

 

 
 

 Click on [Add]. The window "Tool properties" appears. 
Click on [Select] and browse to the wanted directory where your exe-file is 
stored. Choose it.  
 

 

 
 

 With [OK] the program is overtaken into the list. You may add more 
programs or leave the window with [Abort]. 
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 Now you gain direct access to the program via the menu option Tools. 
 

 
  

The list is extendable. 
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Online functions 

 

  

 
Via Online > Online functions or via the according button you may 
activate res. deactivate the online functions. 
The online function buttons appear as symbol bar in the lower area of the 
main window. 
 

 
Online functions at 
Ethernet 
functionality 

 
 

The following describes the online functions in the functionality 
"Ethernet". Please regard that the online functions are only available with 
an Ethernet-CP.  
For the online access to an Ethernet coupler, WinNCS provides special 
functions. 
 

 
To preset the protocol type and station address. 
The IP address is overtaken into the Init dialog as soon as an online 
function is executed. 
 

 
 

 
Establishes a connection between your PC and CP using the 
communication parameters given under Init. 
An online connection is the precondition for the following functions.  
 

 
Sets the CP into RUN state (Software-RUN). Herefore, the RUN/STOP 
levers of the CPs have to be in position RUN. 
 

 
This button sets the CP STOP state (Software-STOP) even if the 
RUN/STOP lever of the CP is in position RUN. Before transferring a 
project into the CP, the CP has to be set in Software- STOP.  
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This function shows the recent operating state (RUN / STOP) of the CP in 
the status bar of the main window. 
 

 
If your CP is in (Software-) STOP, you may transfer your project into the 
CP via this button.  
 

 
This function imports the project engineering from the PC into WinNCS. 
 

 
This function transfers your project from the CP-RAM into the internal 
Flash-ROM. You need this function after the project transfer depending on 
the used CP. 
 

 
This button initializes an overall_reset. An overall_resetsets the CP back 
into delivery state. The project is deleted and the original IP address is 
assigned. 
Before an overall_reset you have to set the CP to STOP state. 
Afterwards, the CP has to boot again. Switch the voltage supply of the CP 
off and on again.  
 

 
The Identification mask shows all parameters that are necessary for the 
unambiguous identification of a CP. All parameters of this mask are only 
for monitoring purpose and may not be altered here.  
 

 
This button opens an output window with the Indicator words from 0 to 
223. The indicator words are monitored as Byte in hexadecimal format.  
The indicator word of the order number 0 has a special function. The 
order number 0 contains the number of the order that is recently executed 
by SEND ALL res. RECEIVE ALL in the module. 
 

 
Monitors the summary state of all connections.  

 
Monitors the summary state of all H1 transport connections 

 
Monitors the summary state of all H1 datagramm connections 

 
Monitors the summary state of all TCP connections 

 
Monitors the summary state of all UDP connections 

 
A click on the button Status and Control opens an operand table. Enter 
here the operands that you want to visualize res. alter. 
As soon as you have a connection to the destination station, WinNCS 
automatically sets the operand format and transfers the status values to 
the monitor.  
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Online functionen at 
Profibus 
functionality 

 
 

The functionality "Profibus" supports the following online functions: 
 

  
Preset address parameter. 
 

 
 

 
Establishes a connection between your PC and the Profibus-DP master 
using the communication parameters set under Init. 
An online connection is the precondition for the following functions. 
 

 
This function transfers your Profibus project into the DP master. 
 

 
This button allows you to import a project from the DP master into 
WinNCS. 
 

Online functions at 
System 200V 
functionality 

 

The functionality "System 200V" does not support online functions. 
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"Network" window 

 
General 

 
The "Network" window gives you an overview of your complete project 
engineering. Here you may configure several systems at one time and 
store them centrally in a data base.  
The single stations are shown with their subordinated modules, system 
components and connection orders in a tree structure. This view is 
common for Windows and the usage is easily learned.  
The "Network" window always appears together with the "Parameter" 
window. 
 

"Network" window   

 
 

Areas [1]  Functionality 
Here you choose which functionality is provided by WinNCS. You may 
choose between Ethernet, Profibus and System 200V functionality. You 
may only work on those projects that have the selected functionality. 
[2]  Network elements 
Depending on the functionality and the position in the network list, the 
according network elements are listed. By means of a mouse click, they 
may be inserted into the network list at the recent position.  
[3]  Network list 
The network list gives you an overview over your complete project. The 
position in the network list influences the content of the "Parameter" 
window and the  activation of network elements. 
Every level of the network list may be expanded like known from Windows 
when a Plus [+] is beside the symbol. 
A [+] means that there are further symbols on lower levels. Expand it by 
clicking on [+] and reverse it with a click on the then appearing Minus [-] 
beside the main symbol. 
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Symbol bar of the "Network" window 

 
General 

 
The headline of the network window shows the functionality that has been 
set via Extras or via symbol bar  of the main window.  
Depending on the chosen functionality, you will find the following buttons 
on the symbol bar: 
 

Function group 
Ethernet 

 

The symbol Function group groups several stations of one functionality to 
a logical block. 
The functionality "Ethernet" allows you to configure your Ethernet 
components. 
This functionality has the following control buttons: 
 

Ethernet station 

 

This button adds an Ethernet station into your network. Afterwards you 
parameterize the connections for this station. 
 

TCP connection 

 

Add a TCP connection via this button. A TCP connection transfers the 
data connection orientated with acknowledgement of the partner station. 
You may also configure your TCP connection as multi connection. 
 

UDP connection 

 

This symbol assigns an UDP connection. The UDP connection provides a 
connection free, not always reliable communication service. 
 

H1 transport 
connection 

 

For H1 transport connections you click on this symbol. H1 transport 
connections allow a connection orientated communication via the H1(TP4) 
protocol. 
Please regard that not all CPs support the H1 protocol. More detailed 
information is to find in the documentation of your CP. 
 

H1 datagramm 
connection 

 
 

This button assigns an H1 datagramm connection. H1 datagramm 
connections are, similar to the UDP connections, unsecured connections 
of the H1(TP4) protocol. 
 

Ethernet coupler 

 

Via this button, you insert an Ethernet coupler into your network for which 
you afterwards configure the according modules.  
 

Modules 

 

Insert the modules connected to the Ethernet coupler via this button. 
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Function group 
Profibus 

 

The functionality "Profibus" allows you to configure your Profibus-DP 
master.  
This functionality provides the following buttons: 
 

Profibus-DP master 

 

This button inserts a Profibus-DP master into your network list. 
 

Profibus-DP slave 

 

Ti insert a DP slave, you click on this button. Using GSD-files, you may 
also include Profibus slaves of other manufacturers into WinNCS. 
 

Modules 

 

Modules that are connected to the DP slave are assigned via this button. 
  
 

Function group 
System 200V 

 

Via the functionality "System 200V" you may create central 
configurations of a CPU for STEP5 from Siemens and the concerning 
modules. Via the export function you may export the parameter and 
configuration data as DB1 data block into a s5d-file.  
This functionality provides the following buttons: 
 

CPU 

 

Add a CPU to your network list with this button. 
 

Modules 

 

Insert the modules that are connected to the CPU. 
 
 

General functions 
 

 

Delete 

 

The recently selected symbol is deleted from the "network" window. All 
lower positions are automatically also deleted.  
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Import / Export 

 

 Import 

 Export 

 
Via the context menu, the "network" window allows you to import your 
data basic file into the network res. to export a station from the network as 
data basic file.  
Depending on the selected functionality, the export creates a file (in the 
following called data base) with CPU/Station and module data and stores 
it in the format of your hardware platform. This data base may 
betransferred into the according module.  
Depending on the selected functionality, the import inserts the data base 
with CPU/Stations and module data into the "network" window. 
 

     

Note! 
Please regard that the data is always inserted below the recent cursor 
position in the "network" window.  
 

Import/Export 
options 

The following text lists the Import/Export options for the different 
functionalities: 
 

Functionality 
"Ethernet" 

The functionality "Ethernet" imports and exports projects as NCS-file. The 
import also supports NCS-files created with the MS-DOS projecting tool 
NCS Version 2.62 or higher. 
 

Import: ncs-file H1/TCP/IP symbol is added and the network build-up. 
Export: ncs-file Station parameter and connection data is exported. 

 
Functionality 
"Profibus" 

The functionality "Profibus" is able to import projects that have been 
created with the projecting tool COMProfibus from Siemens. You may 
also export a created Profibus system as 2bf file.  
 

Import: 2bf- file from COMProfibus fom Siemens or from WinNCS. 
Export: 2bf- file Bus parameters and master project engineering of the 

master selected in the "network" window are exported. 
Assignment: 2bf- file The functionality "System 200V" allows you to point to an 

(already exported) 2bf file to reserve an address. 
More detailed information is to find under the register module 
configuration. 
 

Functionality 
"System 200V" 

The functionality "System 200V" supports only export! 
  
 

Export: s5d- file Configuration data for CPU and modules (incl. DB1) 
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"Parameter" window 

 
"Network" window 
"Parameter" 
window 

 
WinNCS stores the parameterization data of all stations in a database. 
Together with the "network" window a structured view of large systems 
with many single stations is possible.  
The "parameter" window shows the database mask depending on the 
position of the cursor in the "network" window. If the cursor in the 
"network" window is on a function group symbol, the function group 
database mask is shown, at a station, the station database mask and if 
the cursor is on a connection, the accoring connection database mask. As 
soon as a new symbol is added to the "network" window, the parameter 
window creates a new database mask with presetted parameters. 
"Network" and "parameter" window are in direct connection to each other 
and are always up-to-date after applying a record set.  
 

 

 
 
Apply 
Cancel 

 
Depending on the chosen element, the "parameter" window shows 
different register cards.  
With [Apply] you take the alterations of all registers over to the database 
and they are stored automatically.  
[Cancel] sets back the changes in all registers. 
After applying a record set, the "network" window monitors the name of 
the according function group, station or connection.  
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I/O Map - Overview address area 

 
Map 

 
If you click on [Map] in the parameter window, another window opens that 
monitors the assignment of the peripheral address area.  
Here you may see from which address offset on the in- res. output data of 
the chosen module is stored.  
For in- and output area the window has each one register. 
 

 

3
4

1 2

5

 

[1] Each one register for in- and 
output area 
[2] Legend 
[3] The address range of the 
currently marked module is shown 
in full color. 
Here for example, the module maps 
its 8Byte input data starting with 
address 2. 
[4] Address areas that are occupied 
by other modules are shown in 
halftone. 
[5] Not used addresses are shown 
in white. 
 

    

Please regard that not all areas are used by every functionality and the 
"Map" button is not everywhere available. 

 Depending on the functionality the I/O map shows the following 
information:  

 Ethernet functionality (only Ethernet coupler) 
    (blue) Address area that is occupied in the Ethernet coupler by 

the modules.  
 

 Profibus functionality 
    (red) Shows address areas that are reserved. 

You may reserve each up to 4 address areas for in- and 
outputs. These areas are protected at the automatic 
address allocation.  

    (blue) Address area that is occupied in the CPU by the 
modules that are connected via Profibus.  
 

 System 200V functionality 
    (green) Address area that is occupied by the central connected 

modules of the CPU. 
    (yellow) Marks the address area that is used by a periphery 

integrated in the CPU. 
  and  see Profibus functionality 
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Symbol manager 

 
Edit > 
Symbolism 

 

 
The symbol manager allows you to assign symbolic addresses to the IP 
and Ethernet addresses. When the tick box "Symbolic display" is 
activated, all input and selection fields in WinNCS are using the symbolic 
names instead of the address.  
The symbol manager is only available with "Ethernet" functionality. 
Please regard that the list of symbols is not stored with the project. A 
created symbol list can be stored with a file name. A stored symbol list 
can be loaded into the symbol manager. At restart of the program always 
the last symbol list is loaded.  
 

 
Name is limited to 
20 characters 

A name may have a max. of 20 characters. There are no other 
conventions for names.  
 

     

If you assign a name more than one time to Ethernet res. IP addresses 
this is recognized and monitored.  
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Activation of the 
symbolic view 

The activation happens by ticking "Symbolic display". 
 

 
Ping function 

 

The symbol manager has an integrated Ping function. This allows you to 
proof if the destination module is physically in the net by typing the 
according IP address. 

 

Help system 

 
Menu option ? 

 
WinNCS provides various help functions. During parameterization you 
always have access to the help topics that are in the main menu under the 
menu option?.  
 

Function key F1 If you need help in the WinNCS window, strike the function key F1 in the 
according window or the input screen. A context related help window 
appears. 
 

Help topics The call of help topics opens a help window with an overview of the help 
topics sorted in categories. Clicking on a book symbol you reach the 
wanted topic. There may be other topics below.  
Via double click on a topic you may read the help text. With a double click 
on an open book, you close it again.  
For a topic search you may type an expression directly into the window or 
search in the index.  
 

 More detailed information about the help system is to find in the description 
of your Windows system or by striking F1 in the help window. 
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Context menu 
 
General 

 
For WinNCS is programmed after Windows conventions, the program also 
offers a context menu that is activated via the right mouse button. This 
menu gives you direct access to functions that are only available at this 
mouse position. 
 

Functions  Depending on the mouse position, the context menu contains: 
 

Insert mode Activate res. deactivate the insert mode 
 

Copy Strg/Ctrl+C Copy marked data 
 

Insert Strg/Ctrl+V Insert mode active: Insert at current position 
Insert mode not active: Insert at end of list 
 

 Start Set CP into Run state 

 Stop 
Set CP into Stop state 

 Status 
Request recent CP state 

 Delete 
Delete data base at the PC 

 Download 
Transfer data base from PC to CP. 

 Upload 
Transfer data base from CP to PC. 

 Flash 
Transfer data base from CP into internal Flash 

 Info 
Monitoring station parameter 

 Indicator word 
State of the indicator words 

 All 
Summary state for all connections 

 Trans 
Summary state of H1 transport connections 

 Data 
Summary state for H1 datagramm connections 

 TCP/IP 
Summary state for TCP/IP connections 

 UDP 
Summary state for UDP connections 

 Control VAR 
State and control of the operands 

 Import 
Import data base into network  

 Export 
Export station from the network as data base 
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WinNCS for CPs 

Outline 

 
TCP/IP- and 
H1- CPs 

 
The Ethernet functionality allows you to engineer your TCP/IP and H1-
CPs. 
The project engineering includes directly the CPs as well as the 
connections of the CPs.  
 

Engineering options As soon as you've configured your CP, you may transfer your project 
engineering to the CP, depending on the CP online via the existing 
network, directly serial or via MMC. 
At the online transfer, the data is send either via TCP/IP or via H1 (TP4-
Stack required) by giving the according IP res. Ethernet address. 
Via different status functions you may request the status of the CP online 
and start or stop the CP.  
You may execute an online firmware update. This functionality requires a 
password. 
 
For the concrete access options of your CP, please refer to the according 
manual.  
 
Starting with CP firmware V.213 all listed online accesses to the CP are 
possible. For detailed information refer to the manual of the CP. 
 

Search and import 
stations 

Starting with version 3.12, WinNCS is able to search stations in the 
Ethernet and to import their project engineering. 
Please take care that PC and CP are in the same IP circle. Otherwise you 
need an IP circle switch at the PC.  
You may also alter the IP address of your CP online to fit it into the IP 
circle of the PC. Please regard that this action deletes the configuration in 
the CP.  
 

Import options Under Ethernet functionality, you may im- or export projects as ncs-file. 
You may also import ncs-files created with the MS-DOS-NCS projecting 
tool Version 2.62 or higher.  
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Building up the network 

 
Outline 

 
For the communication via TCP/IP res. H1 you need some presettings 
and driver installations, described in the following.  
 

Configuration for 
TCP/IP 

To communicate with the CP via TCP/IP protocol, the CP and the local 
computer have to be connected via a network. For this you need a 
network card that must be included in your operating system as a 
hardware component.  
The recent network configuration is monitored in the system control 
under network. If not already done, add the network components for the 
TCP/IP protocol.  
 

 Furthermore, the network component TCP/IP needs an IP address via 
[Properties]. The IP addresses of the local computer and the CP must be 
in the same IP circle to be able to communicate with each other. Ask your 
system operator for the IP addresses.  
 

     

Note! 
Please regard that you have to adjust the IP circle of your projecting PC to 
the IP address of your CPU for the transfer via Ethernet at the first project 
engineering. 
Every IP address must be unique within the network. 
 

Change IP circle To change the IP circle, click on network neighborhood with the right 
mouse button. Via Properties you reach a dialog window where you may 
type a new IP address and subnet mask depending on the operating 
system.  
 

    

Note! 
Before you start changing the properties, please note the recent settings 
of the network properties.  
Please regard that every IP address must be unique within the network.  
 

 For example: For access via Ethernet to the address 172.16.192.11 you 
set the network card of your projecting PC to the following IP address: 
172.16.192.X, where "X" can be one number between 0 and 255 except 
11. 
For the subnet mask you set: 255.255.255.0   
 

Change IP circle  
at the CP 

Starting with the CP firmware version V.213, you can online adjust the IP 
address of a CP that is not in the IP circle of your PC. [Search Slaves], 
click on a found CP and select the Ethernet parameter window of 
WinNCS.   
Due to technical reasons, the assignment of a new IP address deletes the 
current configuration of the CP.  
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Configuration for 
H1 

The consignment of WinNCS includes an H1 driver. This driver contains 
the H1 protocol stack for the H1 communication between WinNCS and the 
CP. 
The driver has to be installed under WINDOWS-NT4 or WINDOWS 2000 
and is only useable for this operating systems. The installation happens 
via the network neighborhood. 
Please regard that not all CPs support the H1 protocol. More detailed 
information is to find in the CP manual.  
 

Installation under 
Windows NT4 

 

Click on Network neighborhood at the desktop with the right mouse 
button and select Properties. A dialog window with several registers 
opens.  
Select the register Services and add the delivered H1 driver.  
 

 
 

 Mark the new H1 driver and click on Properties. Another window opens 
where you may insert or delete network cards in the system. WinNCS and 
the H1 driver support up to four cards.  

 You may set a hardware filter for the H1 driver to avoid that all telegrams 
reach the system via the network card.  
This filter allows the following adjustments:  
Directed Only the telegrams related to the address reach the system.  
Promiscuous mode All telegrams reach the system. 
The max. number of connections supported by the H1 driver is set in the 
field Max Connections. 
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Installation under 
WINDOWS 2000 

 

Click on My Network Places on the desktop with the right mouse button 
and call the Properties. The following dialog window appears. 
 
 

 
 

 Click on Local Area Connection. Another dialog window appears.  
 

 
 

 Click on Properties.  
Click on Install in the next dialog window.  
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Installation under 
WINDOWS 2000 

Select Protocol in the next dialog window and click on Add.  
 

 
 

 The following dialog window appears: 
 

 
 
Insert the WinNCS-CD and click on Have Disk. You find the driver 
H1PROT.INF on the CD under H1\WIN2000. Select and install it.  
 
After the installation you have to reboot the PC. 
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Fast introduction of WinNCS with CP 

 
Outline 

 
The project engineering of the CP portion happens in 3 parts: 
• CP project engineering via WinNCS (Connection to Ethernet) 
• Hardware configuration (Include CP in CPU) 
• PLC programming via user application (Connection to PLC). 

  
CP project 
engineering under 
WinNCS 

• Start WinNCS. 

• Click on  to select the functionality "Ethernet". 
• Create a new project with the function group "Ethernet" via File > 

Create/open project. 

• Add a new station via . Now you reach the parameter window 
"CP-Init". 

• Type Station name, IP address and Subnet mask and click on [Apply]. 
• If needed, you get the IP address and the subnet mask from your 

system operator. The other entries remain unchanged. 

• To engineer connections, click on . Type the according 
parameters for order type, order model, order no., priority, IP addresses 
and ports and click on [Apply]: 

 
Transfer the CP project 
Depending on the used CP, you have the following possibilities to transfer 
the WinNCS project: 
a) Transfer directly via Ethernet 
b) Transfer via CPU deploying a MMC 
c) Transfer serial  
 
Information about the transfer methods supported by your CP res. CPU is 
in the according manuals for the devices.  
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to a) Transfer 
directly via Ethernet 

At the transfer directly via Ethernet, you establish an Ethernet connection 
between WinNCS and your CP by choosing the according destination IP 
address.  
Precondition: Same IP circle for PC and CP.  
• Connect the CPU with the Ethernet. 
• Turn on the power supply of the CP (start-up 30s).  

• Activate the online functions via . 

• Set "IP protocol" under  and type the current IP address of the 
CP.  

• Establish a connection via . 

• Set the CP into software STOP via  and select the according 
station in the network window. 

• With , the transfer into the CP starts. If a request for a NCS file 
appears, you forgot to choose the correct station! Return to the last 
step, choose the correct setting and start the transfer again. 

• As soon as the transfer has finished, reboot the CP via .  
 

to b) Transfer via  
CPU with MMC 

At the transfer via CPU and MMC, you export your project as ncs-file and 
copy this to an MMC. The MMC can be plugged into the CPU and 
transferred to the CP.  

• Mark the station and choose  Export via the right mouse button.  
• Name the file as webcp.ncs (CP project) and transfer it to your MMC. 
• Set the RUN-STOP switch of your CPU to STOP and turn off the power 

supply. 
• Plug this MMC into the CPU and turn on the power supply. After a short 

start-up time, the alternating blinking of the LEDs SF and FRCE shows 
that the CP file has been found on the MMC. 

• You start the transfer by tipping the RUN-STOP switch into position MR 
within 10s. During the data transfer the LEDs SF, FRCE and MMC are 
blinking alternating. The transfer has been finished successful when all 
CPU-LEDs are on. If these are blinking fast, an error has occurred.  

• Turn off your power supply, take out the MMC and turn on the power 
supply again. CPU and CP are rebooted. Now the CP is on the network 
with the assigned IP address. 
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Hardware 
configuration 

Via the hardware configuration the according CP has to be included into 
the peripheral area of the CPU.  
For example, the inclusion of the CP portion of a NET-CPU has the 
following approach: 
  
Precondition: SIMATIC manager from Siemens V. 5.1 or V.5.2 with SP1 
and SIMATIC NET  
• Start the SIMATIC manager from Siemens with a new project. 
• Add a new System300 station via Insert > Station > SIMATIC 300-

Station. 
• Activate the station "SIMATIC 300" and open the hardware configurator 

by clicking on "Hardware". 
• Configure a rack (Simatic300 > Rack-300 > Profile rail). 
• For all CPUs 31x are configured as CPU 315-2DP, you select the CPU 

315-2DP with the order no. 6ES7 315-2AF01-0AB0 in the hardware 
catalog.   
This is to find under Simatic300 > CPU-300 > CPU 315-2 DP. 

• Insert the CP343-1 TCP at the plug-in location 4 (Simatic300 > CP-300 
> Industrial Ethernet > CP 343-1 TCP). 

• Via a double click on the CP 343-1 TCP you open the properties window 
and you type that IP address into properties that you have defined in 
WinNCS. 

• If needed parameterize the CPU res. the modules. The parameter 
window is opened at double click on the depending module. 

• Save your project. 
 The transfer of the hardware configuration happens together with the user 

application. 
 

User application For the data transfer between CP and CPU an user application is required 
that contains the communication blocks. A library with the according 
handling blocks is in the consignment of your CPU. The user application 
should have the following structure: 
• Create a communication channel between CPU and CP by means of 

the SYNCHRON block. 
• Program the according SEND and RECEIVE blocks for initializing send 

and receive orders. 
• Program the blocks SEND_ALL res. RECEIVE_ALL for data transfer. 
This is the end of the fast introduction. The following pages contain a 
detailed description of the project engineering. 
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Create new res. import a CP project 

 
Create new  
Ethernet project  
 
 
 

 
Start WinNCS. 

 
Funktionality 
Ethernet 

 
 

Click on  to set the functionality "Ethernet". 
 

File > Create/Open 
project 

 

Create a project with the function group "Ethernet" via File > Project 
create/open. 
You get a file selection window where you can type a name for your 
project file. If you type the name of an already existing file it will be 
opened.   
The project files of WinNCS have "vpr" as extension. The file names of 
the four last recent opened projects are listed in the file menu and can be 
opened directly.  
As soon as you confirm your entries, the "network" window with the 
concerning "parameter" window appears. 
The "network" window shows your new Ethernet net. The "parameter" 
window serves for example the assignment of a symbolic name for the 
network. 

With a click on  in the "Network" window you may add further 
networks with the selected "Ethernet" functionality to your project.  
 

 

 
 
Additionally to the "network" window, the "parameter" window opens. The 
"parameter" window serves the parameter setting for the elements of the 
"network" window. For example you may here assign a symbolic name for 
the network that is then used in the "network" window. 
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Search and import 
an Ethernet project 

Starting with WinNCS version V 3.12 you have the comfortable possibility 
to search stations in the Ethernet and to import their project engineering.  
 

 By means of a click on the Ethernet level, you reach the "parameter" 
window with the search functions. 
 

 
The search supports the following systems: 
[Search slaves]  Search all Ethernet coupler 
[Search stations]  Search all Ethernet-CPs 
 
A click on [Search slaves] starts the search for all Ethernet coupler in the 
network. 
The available couplers are listed. Via double click you import the project of 
the current station and monitor it in the "network" window for further 
configuration. 
 

    

The online search is for the complete network up to the gateway.  
All listed Ethernet coupler may be engineered online. 
With CPs you have to regard that the engineering PC has to be in the 
same IP circle than the CP. 
 

Import of NCS- 
files from older 
WinNCS versions 

 Import 

The Ethernet functionality allows you to import and export projects as ncs-
file. You may also import ncs-files of the MS-DOS-NCS configuration tool 
Version 2.62 or higher.  

Go to the network level in the network window and choose  Import in 
the context menu (right mouse button). 
A file selection window opens. Choose the according ncs-file. As soon as 
you confirm your entry, the ncs-file is imported and included into the 
network as station.  
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Alter an CP project 

 
Preparation 

 
Load the project you want to alter or create a new one.  
As soon as you've loaded res. opened your project this is monitored in the 
"network" window with according "parameter" window. 
Starting from a network symbol that shows the functionality, the "Ethernet" 
functionality allows you to set stations, connections or modules and to 
parameterize them in the concerning "parameter" window.  
 

Difference between 
Ethernet coupler 
and Ethernet-CP 

WinNCS separates the following groups that can be engineered:  
• Ethernet coupler res. slave IM 253NET 
• Ethernet-CP stations and CPUs with CP portion 
The combination of both groups is not possible but you may create one 
network for every group within a project.  
 

 
In basic, both groups are engineered identically. 
 

Project engineering Depending on the position in the network list, the upper part of the window 
contains symbols that can be used for the construction of a network.  
Engineer the wanted station by clicking on the according symbol.  
Do your settings in the concerning "Parameter" window.  
 

    

Note! 
You may only return to the "network" window when you confirm your 
entries via [Apply]. When you click on [Cancel], your station is deleted res. 
your entries are. 
 

 If you now click on the station in the "Network" window, you get a list of 
network elements useable for this station.  
At an Ethernet coupler you may set modules, at a CP station connections.
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Parameterization of a CP  

Parameter Ethernet 

Register Function group 
  

 
 

Name Here you may assign a name for your function group (max. 32 
characters). The name is for a better overview. There are no restrictions 
for the name but it is urgently advised to use unambiguous names for 
function groups.  
As soon as you [Apply] your entries, the name is taken over and shown in 
the "network" window. 
 

 
Search all Ethernet coupler 
 

 
Search all Ethernet-CPs 
 
A click on a search button starts the search for all available stations res. 
Ethernet coupler in the net. 
Available stations are listed. Via double click on the wanted station, the 
according project is imported and monitored in the "network" window for 
further parameterization. 
 

    

The online search is for the complete network up to the gateway. All 
available Ethernet couplers may be engineered online.  
With CPs you have to take care that the project engineering computer is 
within the same IP circle like the CP. 
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Online search of 
CPs 

 
With a click on [Search stations], an online search for CPs is executed 
and all found CPs are listed. Additionally the button [Change IP] appears. 
 

 
   

 
As soon as you click on a CP in the CP list, you may change the IP 
address res. the subnet mask with [Change IP]. 
For this function deletes the project engineering in the CP, a password is 
required that is given at the CP project engineering.  
In delivery state, the password is 00000000 (8xzero). 
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 As soon as you set an IP address, subnet mask and a valid password, the 
new address data is transferred to the CP via [Apply]. The data transfer 
and the progress of the reboot is shown in WinNCS via a progress 
indicator. When the CP has ready booted, you get an acknowledgement 
and WinNCS returns to the dialog "Function group".  
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Parameter CP 

 

 

 
You reach the "parameter" window by clicking on an Ethernet CP in the 
network list  

 

 
 The "parameter" window contains the following registers: 

• CP-Init (Basic initialization of the CP) 
• Firmware (Online firmware update) 
• Reboot (Start online reboot at the CP) 
• Password (Password for online engineering and firmware update) 
• IP-List (Access protection for IP addresses) 
• Clock-Init (Parameterization as time master) 
• Parameter-IP (System parameter for the IP protocol) 
• Parameter-H1 (System parameter for the H1 protocol) 
• Sysconfig (Parameter for Performance improvement) 
• Domain Name System (Symbolic address assignment for TCP/IP) 
• Gateway (Translation of serial data to Ethernet protocol) 
 

    

Note! 
Please regard that not every CP supports all parameters. For more 
detailed information refer to the description of your CP. 
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Register CP-Init 
  

The register CP-Init contains the basic initialization of your CP. Here you 
parameterize addresses and other identification parameter of the CP. 
 

 

 
 

Date, Version The entry of date and version serves your own documentation. It always 
shows the last parameterization alteration. The version number follows no 
restrictions.  
 

Station name You may assign a name for the station (max. 19 characters). Station 
names serve the overview and eases the parameterization of 
connections. Please take care with the symbolic addresses that the 
symbolic name of a station res. its address and the station name of the 
parameterization here are identical.  
This allows a stringent name assignment.  
 

Page frame  
basic address 

The page frame basic address fixes the start address of the 4 
communication page frames that are mapped into the memory area of the 
control. Normally the PLC program works in the basic page frame. The 
other page frames are -if available- used by other controls in the system.  
The page frame basic address must be divisable by 4 and is in the range 
between 0 and 252, i.e. you may insert the following values: 0, 4, 8, 12, ... 
252. Within one control, the page frame basic addresses must not 
overlap. Some CPs are fixed to a page frame basic address of 0. 
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Page frame number Here you set how many page frames are used by the CP to communicate 
with the PLC. Some CPs are fixed to a page frame number of 1.  
 

Station address Type the Ethernet address (station address) that is required for the H1 
communication.  
 

IP address Die IP address is a 32Bit address that must be unique within the network. 
The address is a combination of 4 numbers separated by a dot.  

 To build-up private IP networks within the internet, RFC 1597/1918 
reserves the following address ranges: 

 
 Class A: 10.0.0.0 ... 10.255.255.255 
 Class B: 172.16.0.0 ... 172.31.255.255 
 Class C: 192.168.0.0 ... 192.168.255.255 

 
 Your system operator has the IP address that is required for TCP/IP 

communication. The original IP address is to find on a label on the CP. 
 

Subnet mask The IP subnet mask is a 32Bit filter mask for IP addresses. Deploying 
subnet masks, subnets are build-up by definition of IP number circles. 
Subnets only communicate with each other via router.  
The address entered here has the same structure and value range like the 
IP address. For the project engineering of a CP with the PC, you have to 
make sure that PC and CP have the same subnet mask. 
 

Router A router is able to connect different network topologies with each other 
like e.g. Ethernet with token ring. It also serves the connection of subnets. 
Router have one IP address per network that connect the networks 
logical. A connection of 2 networks via router has 2 addresses.  
If you don’t want to use router IP addresses you enter 0.0.0.0 at router.  
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Register Firmware 
  

Depending on the used firmware on the CP, this register allows you to 
execute an online firmware update. 
As soon as you have given a firmware file and a valid password and click 
upon [Apply], the firmware is transferred online to the CP defined by the 
IP address and activated. 
This function is password protected. The password is preset in the 
register Password. 
 

 

 
 

IP address This field contains the IP address of the destination station for the 
firmware update. Per default, the IP address of the currently engineered 
station is entered. The given IP address can be changed. 
 

Firmware 
Click on  and choose a valid firmware file. The firmware may only be 
transferred with a valid password. 
 

Password Type the valid password for the CP portion The password in delivery state 
is: 00000000 (8xzero). 
The alteration happens in the register Password. 
 

[Apply] firmware 
update  

As soon as you entered IP address, firmware and password, the new 
firmware is transferred to the CP with [Apply] and the CP is rebooted.  
The progress of the reboot and the firmware update is shown via a 
progress indicator. When the reboot is ready, there is an 
acknowledgement.  
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Register Reboot 
 

 

 
Depending on the firmware of the CP, you may execute a reboot online. 
As soon as you entered a destination IP address and a valid password, 
the CP is rebooted with [Apply]. This function is password protected. The 
password is preset in the register Password. 
 

 

 
 

 The progress of the reboot is shown via a progress indicator. When the 
reboot is ready, there is an acknowledgement. 
 

 
IP address This field contains the IP address of the destination station for the reboot. 

Per default, the IP address of the currently engineered station is entered. 
The given IP address can be changed. 
 

Password Enter the password valid for the CP. The password in delivery state is to 
find in the description of your CP.  
The alteration of the password happens in the register Password. 
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Reboot via [Apply] As soon as you click on [Apply], a reboot is executed at the CP. Reboot is 
only possible with valid password.  
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Register Password 
 

 

 
Depending on the used firmware you may assign a password for the 
online firmware update and reboot.  
This dialog window allows you to change the password. Enter the recent 
(old) password and twice the new one.   
A click on [Apply] transfers the new password online to the CP defined by 
the IP address. 
 

 

 
 

    

Note! 
Please regard that the alteration of the password only happens online. 
Thus you have to make sure that your PC is able to communicate with the 
CP via the given IP address. 
 

IP address This field contains the IP address of the destination station for the reboot. 
Per default, the IP address of the currently engineered station is entered. 
The given IP address can be changed. 

Old Password Enter the recent valid password. Every CP is delivered with the password 
00000000 (8xzero). 
 

New Password Type the new password for the CP. The password has to consist of at 
least 8 characters. 
 

Repeat For confirmation of the password, type it a second time. 
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Register IP-List 
  

Starting with version 3.0.8, WinNCS gives you the option to control the 
access to a CP via IP-List. The access control only influences the transfer 
of project data via WinNCS res. from PU into CP and CPU.  
The normal data transfer between CPs and PUs is not influenced. 
By means of the IP-List you may exclude or include IP addresses res. 
address ranges for the project engineering. The access control is only 
active when you choose "WinNCS" or "PU" or both. 
The IP-List is transferred together with the CP project engineering. 
 

 

 
 

Type Type defines the type of the access list:  
Access denied for ... 
IP-List contains IP addresses that are not allowed to access the CP via 
WinNCS res. PU. The not listed addresses have access rights.  
Access for ... 
The list contains IP addresses that have access on the CP via WinNCS or 
PU. The not listed addresses have no access rights.  
 

IP address fields The IP address fields can be filled with single IP addresses or complete 
address ranges. A single IP field has to be entered in the left IP field. After 
[Apply] it is taken over into the right field.  
 

WinNCS, PU Depending on the chosen list type, you may here release or restrict the 
access for WinNCS res. PU. 
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Register Clock-Init 
 

 

 
Every CP is able to work as master if parameterized accordingly.  

 

 
 

    

Note! 
At mixed deployment with Siemens CPs you have to make sure to use the 
MMS time format because this is the only one supported by Siemens.  
 

Clock master When the superordinated master (Clock transmitter) fails, the CP 
parameterized here can get a dynamic master. For this, the CP has to be 
highest priority and you have to use it as clock master. 
For clock master mode you have to enter the destination address 
(Broadcast or Multicast) and at Multicast the destination Ethernet 
addresse. Time format and cycle time must be conform.  
As slave, only time format and cycle time must be conform. 
 

Destination address Broadcast  
When choosing broadcast, the address is set to FFFFFFFFFFFFh. It is 
not changeable. 
The clock telegrams are sent to all bus participants.  
 

 Multicast 
The clock telegrams are only sent to the bus participants that are 
members of the multicast circle given by the address.  
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Address At the setting Broadcast this address is at FFFFFFFFFFFFh. At Multicast 
you type the address for the multicast circle. 
 

Cycle time for  
SYNC telegrams 

You may choose the cycle time for sending a synchronization telegram in 
a range of 1...60 seconds. Default are 10s. 
The synchronization telegram is transferred in MMS or BCD format. 
 

 

Attention! 
Please regard that time format and cycle time must be conformly 
parameterized within the system! The last byte of the Ethernet address of 
every Cp has to be different! 
 

MMS format For the synchronization of foreign modules you may only use the MMS 
format. The clock telegram has the following structure: 

 ---- tttt Byte 0 t: time in ms starting at 0:00 o’clock 
 tttt tttt Byte 1  
 tttt tttt Byte 2  
 tttt tttt Byte 3  
 dddd dddd Byte 4 d: Date in days starting from the 1.1.1984 
 dddd dddd Byte 5  
 vkkk kk-- Byte 6 v: Sign 0=+, 1=-;  

k: time change in 0,5 hours   
 ---- --e- Byte 7 e: 0=time of DCF; 1=time of replacement 

master 
  
BCD format The BCD format is a simpler alternative. Please regard that the BCD 

format is not useable with all CPs. 
 

 1/10s 1/100s Byte 0 Parts of seconds 
 10s 1s Byte 1 Seconds 
 10m 1m Byte 2 Minutes 
 ab10h 1h Byte 3 a: Modus: 0=12h, 1=24h;  

b: 0=AM, 1=PM;  
Hours 

 wwww ---- Byte 4 0=Monday ... 6=Sunday 
 10T 1T Byte 5 Day of month 
 10M 1M Byte 6 Month 
 10J 1J Byte 7 Year 
 v--k kkkk Byte 8 v: Sign: 0=+, 1=- 

k: time change in 0,5 hours   
 ---- 1/1000s Byte 9 1/1000s 
 ssss --em Byte 10 s: Time status: (Click status in ANZW);  

e: Flag: 0=time of DCF; 1=time of rep. mast. 
m: Module valid: 0=valid, 1=invalid 
 

 Module valid means that the recent master-CP could be parameterized 
and does not work with default parameters. 
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Register Parameter-IP 
 

 

 
The IP system parameters show the operating parameter of the TCP/IP 
communication on the network. The values should only be changed for 
very important reasons.  
 

 

 
 

Keep Alive Time This parameter shows the dissipation watch time of the TCP connection in 
ms. The dissipation watch time is the watch time for a connection when no 
telegram traffic occurs.  
Value range: 0 to 999999 ms (Default: 30000 ms) 
 

Window Size Size of the data window. 
Value range: 1 to 65535 (Default: 1024) 
 

Large Packets Num Number of send and receive buffer. 
Value range: 1 to 65535 (Default: 5) 
 

Large Packets Size This setting is fix on 1514 for Ethernet. 
 

Small Packets Num Number of acknowledgement telegrams. 
Value range: 1 to 65535 (Default: 5) 
 

Small Packets Size Size of the small packages. 
Value range: 1 to 65535 (Default: 160) 
 

Timeout Time System internal CP parameter; this value shouldn’t be changed. 
Value range: 1 to 999999 (Default: 10000) 
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Register Parameter-H1 
  

The H1 system parameters are the operating parameters of the level 4, 
required for the slave-master-communication. The values should only be 
changed for very important reasons. 
 

 

 
 

Min. Credit The CP uses per se a Credit 0 procedure. The value is fix at 0 and can 
not be altered. 
 

Persistence Count 
 

Value range 0 to 65535 (Default: 1) 
 

Abort Timeout 
 

Persistence count x Abort Time = max. time within the TP4 protocol stack 
establishes the connection res. waits for connection.  
 
Value range 0 to 65535 with unit 10ms (Default: 6000). 
 

Protocol Option 
 

This value is fix at 2 and can not be altered. 
 

Protocol Class 
 

This value is fix at 4 and can not be altered. 
 

TPDU Size 
 

Value range 0 to 13 (Default: 10) 
 

TPDU Additional 
Options 
 

This value is fix at 3 and can not be altered.  
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Retrans. Timeout Time interval for the Connect Retry in time window Abort-Timeout. 
 
Value range 0 to 65535 with unit 10ms (Default: 100) 
 

Min. Retrans Time Retransmission of not acknowledged data frames.  
 
Value range 0 to 65535 with unit 10ms (Default: 10) 
 

Closing Abort 
Timeout 

Maximum time within the partner can acknowledge frames.  
 
Value range 0 to 65535 with unit 10ms (Default: 600) 
 

Flow Control 
Window Timeout 

Idle control of a connection. 
 
Value range 0 to 65535 with unit 10ms (Default: 1000) 
 

Inactivity Max. 
Count 

Idle control of a connection. 
 
Value range 1 to 65535 (Default: 3) 
 

Open Window 
Timeout 

Retransmission of not attested acknowledges with Credit > 1. 
 
Value range 0 to 65535 with unit 10ms (Default: 10) 
 

Max Open Window 
Count 

Retransmission of not attested acknowledges with Credit > 1. 
 
Value range 1 to 65535 (Default: 8) 
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Register System config 
  

With system config, a dialog window for general settings for the system to 
speed-up the performance opens.  
 

 

 
 

SNMP active If chosen, the Simple Network Management Protocol (short: SNMP) is 
used. SNMP controls networks from different manufacturers via a central 
administration-PC. The protocol uses UDP packages for send and 
receive. SNMP allows the system operator to call several SNMP 
information services. This causes the transfer of variables that inform e.g. 
about the module state. 
As default SNMP is active. 
 

DNS active The Domain Name System (short DNS) is the bridge between symbolic 
name and IP address. This makes the communication more comfortable. 
A DNS server is used where the communication is led via a domain.  
The DNS server administrates the symbolic names and combines the 
symbolic names with IP addresses via the "Host-Name-Table". 
As default DNS is active. 
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DHCP active DHCP stands for Dynamic Host Configuration Protocol. If chosen, the IP 
address for this station is assigned dynamically. Like at the Domain Name 
Server there is a DHCP server that administrates the IP addresses and 
assigns them dynamically.  
Administrators may fix groups of addresses, called „ranges“. At the 
address allocation automatically an address is assigned that is within the 
DHCP section of this part of the network. 
As default DHCP is active. 
 

H1 PDU Size Maximum size of the H1 data blocks in Byte that may be transferred on 
network level. PDU stands for Protocol Data Unit and means one data 
block. 
Value range: 0...65535 
Default: 512 
 

IP PDU Size Maximum size of the IP data blocks in Byte that may be transferred on 
network level. PDU stands for Protocol Data Unit and means one data 
block. 
Value range: 0...65535 
Default: 512 
 

IPC  At the Intelligent Process Communikation IPC, also called spontanous 
operation, data is send to the host for one time on CP request. Afterwards 
only data that has been changed since the last transfer is transferred. The 
IPC is used for communication between host and several CPs.  
This acyclic transfer method is faster and causes significant less netload 
than the cyclic transfer.  
This allows the data aquisition of several hundred PLC systems via 
TCP/IP. 
IPC is only permissible with FETCH order types and is supported by other 
visualization systems.  
As default IPC is active. 
 

Number IPC Lists Type the number of IPC orders.  
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Register Domain Name System 
  

This register collects the data required for the deployment of a DNS server.
 

 

 
 

Host-Name Symbolic name that is used for your system within the domain.   
 

Domain-Name Domain where your automation system is linked-up to like e.g. 
"company.com".  
 

DNS-Server IP address of the computer that serves as DNS server. 
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Register Gateway 
 

 

 
The gateway is a router to translate serial data to an Ethernet protocol 
(TCP/IP or H1) and vice versa. You have to set the following logical and 
physical parameters: 
 

 

 
 

Physicalic 
parameters 

Protocol 
As protocol type, the protocols RK512 and RK512R are available. 
Default: RK512 
 

 Baudrate 
The chooseable baudrates are 150, 300, 600, 1200, 1800, 2400, 4800, 
7200, 9600, 14400, 19200, 38400, 57600, 115000 
Default: 9600 
 

 Data Bits 
5, 6, 7, 8 
Default: 8 
 

 Parity 
None, odd, even 
Default: even 
 

 Stop Bits 
1, 1.5, 2 
Default: 2 
 

 Flow Control 
None, Hardware, XON/XOFF 
Default: Hardware 
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Logical parameters 
for 3964/RK512 

ZNA 
Time after the send order in ms 
Default: 0 
 

 ZVZ 
Check EOM for reception in ms 
Default: 200 
 

 QVZ 
Acknowledgement delay time for STX at send in ms 
Default: 500 
 

 BWZ 
Block delay time at reception in ms 
Default: 10000 
 

 STX 
Number of retries for connection initiation. 
Default 3 
 

 DBL 
Number of retries for data blocks 
Default: 6 
 

 Priority 
Priority of the communication 
0 = LOW, >0 = High 
Default: 1  
 

 Buffer Size 
Buffersize for a connection 
Default: 128 
 

 RK512 QVZ 
Time for the logical response telegram in ms 
Default: 5000 
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Engineer CP connections for TCP/IP 

Overview 

 
Precondition 

 
You’ve build-up an Ethernet network with at least one CP. 
 

 
Overview 
connections 
 

 
As soon as the station is high-lighted, you may add following connections to 
your project:  
 
• TCP connection also as Multi-TCP connection 
• UDP connection also as Multi-UDP connection 
 

TCP connection 

 

Add a TCP connection with this button. A TCP connection transfers the 
data to the partner, connection orientated and with acknowledgement. You 
may engineer your TCP connection also as Multi connection. 
 

UDP connection 

 

This symbol assigns an UDP connection to a station. The UDP connection 
is a connection free not always reliable communication service.  
 
 

Combination 
options 

The following tables show the options for order and connection types as 
well as their combination.  
Please regard that not all types are supported by every CP. For more 
detailed information please refer to the according manual.  
 

 Order type Order 
priority 

Structure Order model 

 SEND 1 / 2 Active TCP / UDP / TRADA / RFC 1006
 RECEIVE 1 / 2 Passive TCP / UDP / TRADA / RFC 1006 

 

 SEND 
RECEIVE 

1 / 2 Active TCP / UDP / TRADA / RFC 1006 
(Multi connection) 

 RECEIVE 
SEND 

1 / 2 Passive TCP / UDP / TRADA / RFC 1006 
(Multi connection) 
 

 SEND 3 Active TCP / TRADA 
 RECEIVE 3 Passive TCP / TRADA 

 

 FETCH active 2 (fix) Active TCP / IPK 
 FETCH passive 2 (fix) Passive TCP / IPK 

 

 WRITE active 2 (fix) Active TCP 
 WRITE passive 2 (fix) Passive TCP 



Manual VIPA WinNCS WinNCS for CPs 

HB 91E - Rev. 04/03  61 

TCP connection 

  
The register "TCP connection" allows the entry of connection orientated 
TCP connections. 
TCP provides the secure addressing of the stations by using port 
numbers. 
 

 

 
 

 • Connection name (Identification in the system) 
• Page frame offset, order number (connection to the PLC) 
• Order type, order model, priority (character of the connection) 
• Port, IP address (addressing) 

  
Identification in the 
system 

For the identification in the whole system you may assign a name to every 
connection. 
 

Connection to the 
PLC 

Via the parameters page frame offset and order number the PLC gets a 
reference for a connection. Set them in the handling block via SSNR and 
ANR.  
 

Character of the 
connection 

Order type, order model and the priority characterize a connection.  
Under order type you define the direction (send or receive).  
Order model allows you to choose between single order, transparent data 
transfer without acknowledgement (communication with different telegram 
lengths via header), intelligent process communication (data send only 
after changes) and RFC 1006 (Protocol set for sequential data handling in 
telegrams). 
Priority fixes how to handle the data.  
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Addressing The addressing happens via ports and IP addresses. 
If you’ve typed a station name under host name, the system tries to 
communicate with its host name via a Domain Name Server. This is tried 
for the "attempt" number of times. Afterwards, the IP address is 
automatically used if it is active.  
Without a host name, the station always uses the IP address. For this kind 
of communication, a communication channel defined by ports has to be 
build-up.  
 

unspecified ports 
and IP address  

You may define port and IP address unspecified, i.e. port and IP address 
are not relevant for evaluating telegrams if you type 0 as port address res. 
0.0.0.0 as IP address. The following combinations are possible: 
 

Local Port (S)

Foreign Port (S)

Foreign IP address (S)

(S) Local Port

(S) Foreign Port

(S) Foreign IP address

IP addresses and ports between sender 
and receiver are specified unambiguously.

Sender active Receiver passive

Specified connection

Local Port (S)

Foreign Port (S)

Foreign IP address (S/U)

(S) Local Port

(S) Foreign Port

(U) Foreign IP address

Half specified connection

Local Port (S/U)

Foreign Port (S)

Foreign IP address (S)

(S) Local Port

(U) Foreign Port

(S) Foreign IP address

The IP addresses between sender and 
receiver and the port of the receiver are 
specified. The port of the sender may be 
specified.

Half specified connection

Local Port (S/U)

Foreign Port (S)

Foreign IP address (S/U)

(S) Local Port

(U) Foreign Port

(U) Foreign IP address

The port of the receiver is specified. The 
port of the sender and the IP address of the 
receiver may be specified.

Not specified connection

S=specified          U=unspecified

The ports between sender and receiver are 
specified unambiguously. The IP address 
of the receiver may be specified.
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Parameter TCP connection 
 
Connection name 

 
You may assign a name for your connection. The length is up to 32 
characters. 
 

Page frame offset 
(SSNR) 

The page frame offset (SSNR-Offset) defines the offset to the basic 
interface number (Basis-SSNR). The basic interface number is given at 
initialization. At mono processor operation, the page frame offset has to 
be set at 0. At multi processor systems, the value is between 0 and 3. 
Please regard the following options:  
CPU 1 communicates via page frame 1 (Basis-SSNR+ SSNR-Offset 0) 
CPU 2 communicates via page frame 2 (Basis-SSNR+ SSNR-Offset 1) 
CPU 3 communicates via page frame 3 (Basis-SSNR+ SSNR-Offset 2) 
CPU 4 communicates via page frame 4 (Basis-SSNR+ SSNR-Offset 3) 
Value range: 0 to 3 
 

Order number 
(ANR) 

Every connection that will be called by a PLC handling block needs an 
order number. Together with the page frame offset, the PLC program is 
able to call the connection. Thus, an order number must not exist twice 
and causes an error warning at parameterization in WinNCS. Within the 
control program, the order number (ANR) is given to a PLC handling block 
together with the page frame offset number (SSNR). 
Value range: 1 to 199 
 

Priority 
 

This parameter sets the priority of the telegram on the CP. The priority 
may range between 1 (highest priority) to 3 (lowest priority). 
Connections with the priorities 1 and 2 are –seen from connection link-up– 
so called static connections, i.e. after a connection termination (evtl. 
initialized by a reset handling block) the connection establishing is retried. 
Connections with priority 3 are –seen from connection link-up– so called 
dynamic connections, i.e. after a connection termination the connection 
establishing is not retried. The connection link-up happens by means of 
an order of the application to the connection. If the connection is 
established, it remains active until a termination is initialized.  
Orders with priority 1 differ to the ones with priority 2 and 3 in order 
processing. The size of the user data is limited to the defined block size. A 
block via the ALL handling blocks does not happen.  
These rules are only valid for connection orientated orders via TCP.  
Value range: 1 to 3 
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Order type 
 

Choose the order type. The following order types are available: 
Send Directly Send unstructured data. 
Receive Directly Receive unstructured data. 
Fetch Active Read requested data from another control. 
Fetch Passive Used for the passive part of Fetch. 
Write Active Write requested data in another control. 
Write Passive Used for the passive part of Write. 
 

Order model 
 

The following order models are available: 
Single order 
SEND and RECEIVE receive the telegrams in TCP protocols as user data 
without preceded header. Under the model "single order" the telegram 
data transfer should de defined via fixed telegram lengths! The joker 
length -1 in the RECEIVE-FB is not permissible! 
Trada without acknowledgement 
TRADA stands for TRAnsparent DAta exchange. TRADA serves the 
communication via TCP with differing telegram lengths. The user data is 
preceded by a PLC header that contains the number of user data. The 
order type RECEIVE evaluates this header and the user data is 
transferred to the control with the defined length.  
For this the joker length –1 in the RECEIVE-FB is permissible. 
IPC 
At the intelligent process communication IPC, also referred to as 
spontaneous operation, data is send for one time from the CP to the PC at 
request. Afterwards only the altered data is send. The IPC is used for the 
communication between one PC and several CPs. IPC is only permissible 
with the FETCH order types.  
RFC 1006 
RFC 1006 provides as protocol extension of TCP the secure packaging of 
TCP telegrams. With RFC1006 only SEND and RECEIVE orders are 
permissible. Besides of the IP address TSAPs instead of ports are used 
for the addressing. 
For every SEND order the CP automatically creates a RECEIVE order 
and vice versa. The assignment of order numbers for automatically 
created orders follow some rules.  
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Port address for 
local and foreign 
stations 
 

The port address fixes the connection address where the data is 
exchanged. The port address of the local station is comparable to the own 
TSAP at the H1 level. The port address for the local station consists of a 5 
digit decimal code (16Bit address). TCP as well as UDP use port 
addresses for the data transfer to the according application level. Please 
regard that some ports between 0 and 255 are reserved for special 
services. The port addresses of the local and the foreign station must be 
different from each other.  
Value range: 0 to 65536 
 

IP address The IP address is a 32Bit address that must be unique within the network. 
The address is a combination of 4 numbers separated by a dot.  
Value range: 000.000.000.000 to 255.255.255.255 
At activated IP address, the given IP address is used after the defined 
number of attempts to find a DNS server. Otherwise the station name 
given under host name is used. 
Ask your system operator for the IP address res. the host name. 
 
You may type the port address res. the IP address unspecified, i.e. typing 
0 as port address res 0.0.0.0 as IP address, port res. IP address are not 
relevant for evaluating telegrams.  
 

 



WinNCS for CPs Manual VIPA WinNCS 
 

66  HB 91E - Rev. 04/03 

TCP connection with RFC 1006 
 
RFC 1006 

 
The TCP transport service is stream orientated. This means that data 
packages arranged by the user are not necessarily delivered in the same 
sequence. Packages may be transferred together where the partner is not 
able to identify the packet borders.  
This purpose is fulfilled by the protocol set RFC 1006. The protocol set 
describes the operation mode of an ISO transport interface (ISO 8072) 
based upon the transport interface TCP (RFC793).  
For RFC 1006 runs as protocol set of TCP, the decoding takes place in 
the data section of the TCP packet.  
 

Directives for the 
project engineering 

• At RFC 1006 only SEND and RECEIVE orders are permissible. 
• For every SEND order, the CP automatically creates a RECEIVE 

order and vice versa. The assignment of order numbers has to follow 
this restrictions: 

• SEND orders may only have odd order numbers. The automatically 
generated RECEIVE order gets the next higher odd order number 
(Example: SEND, ANR:5 >> RECEIVE, ANR:6) 

• RECEIVE orders may only have even order numbers. The automatically 
created SEND order gets the next lower order number (Example: 
RECEIVE, ANR:3 >> SEND, ANR:2) 

• The automatically created orders are not monitored in WinNCS. 
• For the addressing, IP addresses and TSAPs instead of ports are 

used. 
• At TSAPs it is separated between small and capital letters.  
• The maximum length of a TSAP is 8 characters. The length has to be 

set in WinNCS. 
• Independent from the used protocol, the standard SEND and RECEIVE 

orders in the PLC are necessary for data transfer. 
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TCP Multi connection 

  
The register "Multi connection" allows you to parameterize multi 
connections. You may install a new connection for a connection 
parameterized under "TCP connection" with reverse order type. The IP 
addresses, port numbers, page frame offset and priority of the already 
configured connection are used. You must only type a new order number. 
At a TCP connection you may parameterize another multi connection now. 
 

 

 
 

 At a multi connection you only have to type a new order number.  
Page frame offset and priority are taken over from the already existing 
connection. At a multi connection these values can not be altered.  
Automatically the reverse order type is set. The addressing (Port, IP 
address) is taken over vice versa. 
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Parameter TCP multi connection 
 
Page frame offset 
(SSNR) 

 
The page frame offset (SSNR-Offset) defines the offset to the basic 
interface number (Basis-SSNR). The basic interface number is given at 
initialization. At mono processor operation, the page frame offset has to 
be set at 0. At multi processor systems, the value is between 0 and 3. 
Please regard the following options: 
 

 CPU 1 communicates via page frame 1 (Basis-SSNR+ SSNR-Offset 0) 
CPU 2 communicates via page frame 2 (Basis-SSNR+ SSNR-Offset 1) 
CPU 3 communicates via page frame 3 (Basis-SSNR+ SSNR-Offset 2) 
CPU 4 communicates via page frame 4 (Basis-SSNR+ SSNR-Offset 3) 
 
Value range: 0 to 3 
 

Order number 
(ANR) 

Every connection that will be called by a PLC handling block needs an 
order number. Together with the page frame offset, the PLC program is 
able to call the connection. Thus, an order number must not exist twice 
and causes an error warning at parameterization in WinNCS. Within the 
control program, the order number (ANR) is given to a PLC handling block 
together with the page frame offset number (SSNR). 
 
Value range: 1 to 199 
 

Priority This value is taken from the defined connection. At a multi connection, this 
value is not alterable.  
This parameter sets the priority of the telegram on the CP. The priority 
may range between 1 (highest priority) to 3 (lowest priority). 
1 is the so called express priority, 2 and 3 are the normal priorities. The 
priorities 0 and 4 are not supported. The express priority has no faster 
data transfer than the normal priorities.  
 
Value range: 1 to 3 
 

Order type The opposite order type is chosen automatically.  
The following order types are available: 
 

 Send: Send unstructured data. 
Receive: Receive unstructured data. 
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TCP system parameter 

  
The register "System parameter" allows you to set areas for the indirect 
addressing and parameters for the intelligent process communication 
(IPC). The indirect addressing is only permissible with the order types 
FETCH and WRITE. 
 

 
 

Indirect addressing You may set a static connection orientated area where information about 
data source, data destination and indicator word are stored. The indirect 
addressing is only permissible for the order types FETCH and WRITE. 
Under Source/destination, you type the data area of the PLC where data 
source/destination are defined.  
In Indicator word you set the data area where the indicator word range is 
defined.  
 

Intelligent process 
communication 

For every connection of the order model IPC you may set a time window 
in timeout within the CP has to communicate with the CPU.  
The maximum size of the IPC data area is defined via the parameter 
PDU-Size. 
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Parameter TCP system parameter 
 
Source/Destination 

 
Gives the source/destination for FETCH/WRITE in the own automation 
device. You may set one of the following values:  
 

 Operand DB-No. Offset Length Type 
 DB 1..255 0..2047 1..2048 Data block 
 MB  0..255 1..256 Bit memory byte 
 EB  0..127 1..128 Input byte 
 AB  0..127 1..128 Output byte 
 PB  0..255 1..256 Periphery byte 
 ZB  0..255 1..256 Counter cells 
 TB  0..255 1..256 Time cells 
 BS  0..511 1..512 System data 
 AS  0..32767 1..32768 Absolute addresses 
 DX 1..255 0..2047 1..2048 Data block extended 
 DE 1..255 0..2047 1..2048 Data block extern 
 QB  0..255 1..256 Periphery byte extended 
 SB  0..4095 1..4096 Extra bit memory 
  
Indicator word Gives a data word of the CPU address area for FETCH and WRITE where 

the data is stored. 
 

 Operand DB-No. Address Type 
 DB 1..255 0..2040 Data block 
 DX 1..255 0..2040 Data block extended 
 MW  0..252 Bit memory word 
  
 Hints to the assignment of data blocks at the indirect addressing is to find in 

the description of your standard handling blocks.  
 

Timeout Type a time window for every IPC connection within which the CP has to 
communicate with the CPU. 
 

PDU-Size The maximum size of the IPC data area.  
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Example for the 
indirect addressing 

Indirect addressing via SEND handling block 
 

 
Call the SEND-HTB 

 
A DB X   ; Open data block x 
SPA FB244   ; Call SEND block 
NAME : SEND 
SSNR : KY 255,1 ; 255-ID for ind. Addr., 1 pointer to DW1 
A-NR : KY 0,0 ; irrelevant 
ANZW : MW 0 ; irrelevant 
 

Data block DB X 
DW 1 KY 0,1 
DW 2 KY 0,31 
DW 3 KC MW 
DW 4 KY 0,200 
 

 The left byte of the parameter SSNR is the switch criterium between direct 
and indirect addressing. If the left byte is > 0, it is an indirect addressing.  
The right byte is –in this case– the pointer to the parameter field.  
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UDP connection 

 

 

 
At UDP the telegrams are transferred without reception 
acknowledgement.  
UDP is convenient for the transfer of permanently changing data. If one 
transfer fails, the next up-to-date transfer comes already after a few 
seconds.  
 

 

 
 

 • Connection name (Identification in the system) 
• Page frame offset, order number (Connection to PLC) 
• Order type, order model, priority (Character of the connection) 
• Port, IP address (Addressing) 

  
Identification in the 
system 

For the identification in the complete system, you may assign an 
according name to your connection. 
 

Connection to PLC Via the parameters page frame offset and order number you set a 
connection identification in your PLC by defining it for your handling block 
via SSNR and ANR.  
 

Character of the 
connection 

Order type, order model and the priority characterize the connection. 
Under Order type you set the direction (send or receive). The Order model 
allows you to choose between Multicast (addressed are all multicast circle 
stations) and Broadcast (send via Broadcast address). The priority defines 
how to handle the data.  
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Addressing The addressing takes place via port and IP address. If you've assigned a 
station name under Host Name, this is used to communicate via a Domain 
Name Server. If this attempts fail after the given number of trials, the 
selected IP address is used if it is activated by a tick. Without a host 
name, always the IP address is used. Please regard that some CPs need 
a port address with UDP.  
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Parameter UDP connection 
 
Connection name 

 
You may assign a name to your connection. The maximum length is 32 
characters. 
 

Page frame offset 
(SSNR) 

The page frame offset (SSNR-Offset) defines the offset to the basic 
interface number (Basis-SSNR). The basic interface number is given at 
initialization. At mono processor operation, the page frame offset has to 
be set at 0. At multi processor systems, the value is between 0 and 3. 
Please regard the following options: 
 

 CPU 1 communicates via page frame 1 (Basis-SSNR+ SSNR-Offset 0) 
CPU 2 communicates via page frame 2 (Basis-SSNR+ SSNR-Offset 1) 
CPU 3 communicates via page frame 3 (Basis-SSNR+ SSNR-Offset 2) 
CPU 4 communicates via page frame 4 (Basis-SSNR+ SSNR-Offset 3) 
 
Value range: 0 to 3 
 

Order number 
(ANR) 

 
Every connection that will be called by a PLC handling block needs an 
order number. Together with the page frame offset, the PLC program is 
able to call the connection. Thus, an order number must not exist twice 
and causes an error warning at parameterization in WinNCS. Within the 
control program, the order number (ANR) is given to a PLC handling block 
together with the page frame offset number (SSNR). 
 
Value range: 1 to 199 
 

Priority This parameter sets the priority of the telegram on the CP. The priority of  
UDP connections is 1 or 2. Priority 1 is the highest priority. 
Connections with the priorities 1 and 2 are –seen from connection link-up– 
so called static connections, i.e. after a connection termination (possible 
initialized by a reset handling block) the connection establishing is retried. 
Orders with priority 1 differ to the ones with priority 2 in the internal order 
processing. The size of the user data is limited to the defined block size. A 
block via the ALL handling blocks does not happen.  
 
Value range: 1 to 2 
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Order type Choose the order type. The following order types are available: 
Send: Send unstructured data. 
Receive: Receive unstructured data. 
 

Order model The model defines the transfer type. You may send unsecure telegrams to 
one receiver, a chooseable receiver group or to all receiver.  
 

Multicast Unsecure order for the chosen multicast circle. This is a connection that is 
not send to all stations but only to those within the same multicast circle 
number. The destination group is defined via the IP address. As soon as 
you choose multicast here, the multicast ID is set in the IP address. 
 

Broadcast Connection free sending of single messages to all partners of the defined 
broadcast address res. reception of single messages from partners 
sending via the defined broadcast address. 
The broadcast address is 255.255.255.255. 
 

Port address for 
local and foreign 
station 

The port address defines the connection address where the data is 
exchanged. The port address for the local station is comparable with the 
own TSAP on the H1 level. The port address for the local station consists 
of a 5 digit decimal number (16Bit address). TCP as well as UDP use port 
addresses for data transfer to the according application level. Please 
regard that some ports between 0 to 255 are reserved for common 
services.  
 
Value range: 0 to 65535 
 

IP address The IP address is a 32Bit address that must be unique within the network. 
The address consists of 4 numbers separated by a dot. Here you define 
multicast circles. Multicast circles are defined in the range 224.0.0.0 to 
239.255.255.255.  
Ask your system operator for the IP address. 
 
Value range: 000.000.000.000 to 255.255.255.255 
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UDP multi connection  

 

 

 
The register "multi connection" gives you the opportunity to parameterize 
multi connections. A multi connection is a multiple connection. You may 
install a new connection for a connection parameterized under "UDP 
connection" with reverse order type. The IP addresses, port numbers, 
page frame offset and priority of the already configured connection are 
used. You must only type a new order number. 
 

 

 
 

 At a multi connection you only have to type a new order number.  
Page frame offset and priority are taken over from the already existing 
connection. At a multi connection these values can not be altered.  
Automatically the reverse order type is set. The addressing (Port, IP 
address) is taken over vice versa. 
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Parameter UDP multi connection 
 
Page frame offset  
(SSNR) 

 
The page frame offset (SSNR-Offset) defines the offset to the basic 
interface number (Basis-SSNR). The basic interface number is given at 
initialization. At mono processor operation, the page frame offset has to 
be set at 0. At multi processor systems, the value is between 0 and 3. 
Please regard the following options: 
 

 CPU 1 communicates via page frame 1 (Basis-SSNR+ SSNR-Offset 0) 
CPU 2 communicates via page frame 2 (Basis-SSNR+ SSNR-Offset 1) 
CPU 3 communicates via page frame 3 (Basis-SSNR+ SSNR-Offset 2) 
CPU 4 communicates via page frame 4 (Basis-SSNR+ SSNR-Offset 3) 
 
Value range: 0 to 3 
 

Order number 
(ANR) 

Every connection that will be called by a PLC handling block needs an 
order number. Together with the page frame offset, the PLC program is 
able to call the connection. Thus, an order number must not exist twice 
and causes an error warning at parameterization in WinNCS. Within the 
control program, the order number (ANR) is given to a PLC handling block 
together with the page frame offset number (SSNR). 
 
Value range: 1 to 199 
 

Priority This value is taken from the defined connection. At a multi connection, this 
value is not alterable.  
This parameter sets the priority of the telegram on the CP. The priority 
may range between 1 (highest priority) to 3 (lowest priority). 
1 is the so called express priority, 2 and 3 are the normal priorities. The 
priorities 0 and 4 are not supported. The express priority has no faster 
data transfer than the normal priorities.  
 
Value range: 1 to 3 
 

Order type The opposite order type is chosen automatically.  
The following order types are available: 
 
Send: Send unstructured data. 
Receive: Receive unstructured data. 
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Engineer CP connections for H1 

Overview 

 
Preconditions 

 
You've build-up an Ethernet network with at least one CP. 
 

 
Overview 
connections 
 

 
As soon as you select a station, you may insert the following connections 
in your project:  
 
• H1 transport connection also as Multi connection  
• H1 datagram connection also as Multi connection 
 

H1 transport 
connection 

 

Insert a H1 transport  connection by means of this button. At a H1 
transport  connection the data is transferred connection orientated with 
acknowledgement of the partner. Here you may also parameterize the H1 
transport  connection as multi  connection.  
 

H1 datagram 
connection 

 

This symbol assign an H1 datagram connection to a station. The 
datagram  connection serves a relation free not always secure 
communication service.  
 
 

Combination 
options 

The following tables list all possible order and connection types with their 
combinations.  
Please regard that not every CP supports all types. Please refer to the CP 
documentation.   
 

 
Order type Order 

priority 
Type Read/Write Order model 

SEND 0 / 1 Active No Datagram 
RECEIVE 0 / 1 Passive No Datagram 

SEND 2 / 3 / 4 Active No Transport 
RECEIVE 2 / 3 / 4 Passive No Transport 
SEND 
RECEIVE 

2 Active No Transport (Multi connection) 

RECEIVE 
SEND 

2 Passive No Transport (Multi connection) 

FETCH active 2 (fix) Active Yes Transport 
FETCH passive 2 (fix) Passive Yes Transport 
WRITE active 2 (fix) Active Yes Transport 
WRITE passiv 2 (fix) Passive Yes Transport 
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H1 transport  connection 

  
The register "H1-Transport connection" allows the entry of connection 
orientated H1  connections.  
H1 provides the secure addressing of the stations by deployment of 
TSAPs. 
 

 

 
 

 • Connection name (Identification in the System) 
• Page frame offset, order number (connection to the PLC) 
• Order type, priority (character of the connection) 
• TSAP, Ethernet address (Addressing) 

  
Identification in the 
system 

For the identification in the whole system you may assign a name to every 
connection. 
 

Connection to the 
PLC 

Via the parameters page frame offset and order number the PLC gets a 
reference for a connection. Set them in the handling block via SSNR and 
ANR.  
 

Character of the 
connection 

Order type and the priority characterize a connection. Under order type 
you define the direction (send or receive).  
Priority fixes how to handle the data.  
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Addressing The addressing happens via TSAPs (Transport Service Access Point) and 
Ethernet addresses. For the communication, a communication channel 
has to be established that is defined by TSAPs. 
The Ethernet address has a length of 6Byte. The first three bytes define 
the manufacturer. These bytes are set by the IEEE comitee. The last 
three bytes are at your disposal. Within a network there must not be more 
than one station with the same Ethernet address. Within company 
systems, the Ethernet addresses are assigned central by the network 
administrator. 
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Parameter H1 transport connection 
 
Connection name 

 
You may assign a name for your connection. The length is up to 32 
characters. 
 

Page frame offset 
(SSNR) 

The page frame offset (SSNR-Offset) defines the offset to the basic 
interface number (Basis-SSNR). The basic interface number is given at 
initialization. At mono processor operation, the page frame offset has to 
be set at 0. At multi processor systems, the value is between 0 and 3. 
Please regard the following options:  
CPU 1 communicates via page frame 1 (Basis-SSNR+ SSNR-Offset 0) 
CPU 2 communicates via page frame 2 (Basis-SSNR+ SSNR-Offset 1) 
CPU 3 communicates via page frame 3 (Basis-SSNR+ SSNR-Offset 2) 
CPU 4 communicates via page frame 4 (Basis-SSNR+ SSNR-Offset 3) 
Value range: 0 to 3 
 

Order number 
(ANR) 

Every connection that will be called by a PLC handling block needs an 
order number. Together with the page frame offset, the PLC program is 
able to call the connection. Thus, an order number must not exist twice 
and causes an error warning at parameterization in WinNCS. Within the 
control program, the order number (ANR) is given to a PLC handling block 
together with the page frame offset number (SSNR). 
Value range: 1 to 199 
 

Priority  
This parameter sets the priority of the telegram on the CP. The priority 
may range between 0 (highest priority) to 4 (lowest priority). 
Connections with the priorities 0, 1 and 2 are –seen from connection link-
up– so called static connections, i.e. after a connection termination (evtl. 
initialized by a reset handling block) the connection establishing is retried. 
 

 Connections with priority 3 and 4 are –seen from connection link-up– so 
called dynamic connections, i.e. after a connection termination the 
connection establishing is not retried. The connection link-up happens by 
means of an order of the application to the connection. For priority 3 is 
valid: if the connection is established, it remains active until a termination 
is initialized. Connection retries of the CP are not executed. At priority 4, 
the connection is terminated automatically after the telegram transfer.  
 
Value range: 0 to 4 
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Order type Choose the order type. The following order types are available: 

 
Send Directly Send unstructured data. 

 
Receive Directly Receive unstructured data. 

 
Fetch Active Read requested data from another control. 

 
Fetch Passive Used for the passive part of Fetch. 

 
Write Active Write requested data in another control. 

 
Write Passive Used for the passive part of Write. 

 
Remote address 
(Adr) 

Here you type the address of the partner station that will communicate 
with this connection. The partner station has to be addressed with an 
Ethernet address. The Ethernet address must be unique within the 
network. 
The Ethernet address has a length of 6Byte. The first three bytes define 
the manufacturer. These bytes are set by the IEEE comitee. The last 
three bytes are at your disposal. Within company systems, the Ethernet 
addresses are assigned central by the network administrator. 
 

Transport Service 
Access Point 
(TSAP) 
 

Via TSAPs connection channels for a connection are build-up with H1. 
The length of a TSAP is between 1 and 8Byte. The assignment may be in 
Hex or ASCII format. 
 

Local TSAP 
 

This is the TSAP of the own (local) station. 
 

Local TSAP length 
 

Sets the length of the local TSAP in Byte.  

Remote TSAP 
 

This is the TSAP of the destination station (foreign station). 
 

Remote TSAP 
length 
 

Sets the length of the foreign TSAP in Byte.  
 



Manual VIPA WinNCS WinNCS for CPs 

HB 91E - Rev. 04/03  83 

H1 transport multi connection 

  
The register "multi connection" gives you the opportunity to parameterize 
multi connections. A multi connection is a multiple connection. You may 
install a new connection for a connection parameterized under "H1 
transport connection" with reverse order type. The Ethernet address, 
TSAP, page frame offset and priority of the already configured connection 
are used. You may also run the multi connection via another page frame 
or priority. At an H1 transport connection, up to three further multi 
connections are possible.  
 

 

 
 

 At a multi connection you only have to type a new order number.  
Page frame offset and priority are taken over from the already existing 
connection. At a multi connection these values can not be altered.  
Automatically the reverse order type is set. The addressing (Port, IP 
address) is taken over vice versa. 
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Parameter H1 transport multi connection 
 
Page frame offset  
(SSNR) 

 
The page frame offset (SSNR-Offset) defines the offset to the basic 
interface number (Basis-SSNR). The basic interface number is given at 
initialization. At mono processor operation, the page frame offset has to 
be set at 0. At multi processor systems, the value is between 0 and 3. 
Please regard the following options: 
 

 CPU 1 communicates via page frame 1 (Basis-SSNR+ SSNR-Offset 0) 
CPU 2 communicates via page frame 2 (Basis-SSNR+ SSNR-Offset 1) 
CPU 3 communicates via page frame 3 (Basis-SSNR+ SSNR-Offset 2) 
CPU 4 communicates via page frame 4 (Basis-SSNR+ SSNR-Offset 3) 
 
Value range: 0 to 3 
 

Order number 
(ANR) 

Every connection that will be called by a PLC handling block needs an 
order number. Together with the page frame offset, the PLC program is 
able to call the connection. Thus, an order number must not exist twice 
and causes an error warning at parameterization in WinNCS. Within the 
control program, the order number (ANR) is given to a PLC handling block 
together with the page frame offset number (SSNR). 
 
Value range: 1 to 199 
 

Priority This value is taken from the defined connection. At a multi connection, this 
value is not alterable.  
This parameter sets the priority of the telegram on the CP. The priority 
may range between 0 (highest priority) to 4 (lowest priority). 
1 is the so called express priority, 2 and 3 are the normal priorities. The 
priorities 0 and 4 are not supported. The express priority has no faster 
data transfer than the normal priorities.  
 
Value range: 1 to 3 
 

Order type The opposite order type is chosen automatically.  
The following order types are available: 
 
Send: Send unstructured data. 
Receive: Receive unstructured data. 
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H1 system parameters 

  
The register "System parameter" allows you to set areas for the indirect 
addressing and parameters for the intelligent process communication 
(only relevant for TCP/IP). The indirect addressing is only permissible with 
the order types FETCH and WRITE. 
 

 
 

Indirect addressing You may set a static connection orientated area where information about 
data source, data destination and indicator word are stored. The indirect 
addressing is only permissible for the order types FETCH and WRITE. 
Under Source/destination, you type the data area of the PLC where data 
source/destination are defined.  
In Indicator word you set the data area where the indicator word range is 
defined.  
 

Intelligent process 
communication 

The IPC parameters are only relevant for TCP/IP and are not used for H1.
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Parameter H1 system parameter 
 
Source/Destination 

 
Gives the source/destination for FETCH/WRITE in the own automation 
device. You may set one of the following values:  
 

 Operand DB-No. Offset Length Type 
 DB 1..255 0..2047 1..2048 Data block 
 MB  0..255 1..256 Bit memory byte 
 EB  0..127 1..128 Input byte 
 AB  0..127 1..128 Output byte 
 PB  0..255 1..256 Periphery byte 
 ZB  0..255 1..256 Counter cells 
 TB  0..255 1..256 Time cells 
 BS  0..511 1..512 System data 
 AS  0..32767 1..32768 Absolute addresses 
 DX 1..255 0..2047 1..2048 Data block extended 
 DE 1..255 0..2047 1..2048 Data block extern 
 QB  0..255 1..256 Periphery byte extended 
 SB  0..4095 1..4096 Extra bit memory 
  
Indicator word Gives a data word of the CPU address area for FETCH and WRITE where 

the data is stored. 
 

 Operand DB-No. Address Type 
 DB 1..255 0..2040 Data block 
 DX 1..255 0..2040 Data block extended 
 MW  0..252 Bit memory word 
  
 Hints to the assignment of data blocks at the indirect addressing is to find 

in the description of your standard handling blocks.  
 

Timeout 
PDU-Size 

This parameters are only relevant for TCP/IP and are not used for H1. 
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Example for the 
indirect addressing 
 

Indirect addressing via SEND handling block  
 

Call the SEND-HTB  
 A DB X  ; Open data block x 
 SP

A 
FB244  ; Call SEND block 

  NAME : SEND  
  SSNR :  KY 255,1 ; 255-ID for ind. Addr., 1 pointer to DW1 
  A-NR  :  KY 0,0  ; irrelevant 
  ANZW:  MW 0  ; irrelevant 
  
Data block DB  X 

DW 1 KY 0,1 
DW 2 KY 0,31 
DW 3 KC MW 
DW 4 KY 0,200 
 

 The left byte of the parameter SSNR is the switch criterium between direct 
and indirect addressing. If the left byte is > 0, it is an indirect addressing.  
The right byte is –in this case– the pointer to the parameter field.  
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H1 datagramm connection 

 

 

 
At datagram connections, the telegrams are transferred relation and 
acknowledgement free. H1 datagram connections are convenient for the 
transfer of permanently changing data. If one transfer fails, the next up-to-
date transfer comes already after a few seconds. The loss of datagrams, 
e.g. if the receive buffer is exceeded, is not recognized.  
 

 

 
 

 • Connection name (Identification in the System) 
• Page frame offset, order number (connection to the PLC) 
• Order type, order model, priority (character of the connection) 
• TSAP, Ethernet address (Addressing) 
 

Identification in the 
system 

For the identification in the whole system you may assign a name to every 
connection. 
 

Connection to the 
PLC 

Via the parameters page frame offset and order number the PLC gets a 
reference for a connection. Set them in the handling block via SSNR and 
ANR.  
 

Character of the 
connection 

Order type, order model and the priority characterize a connection. Under 
order type you define the direction (send or receive). Under order model 
you select between Multicast (addressed are all multicast circle stations) 
and Broadcast (send via broadcast address). 
Priority fixes how to handle the data.  
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Addressing The addressing happens via TSAPs (Transport Service Access Point) and 
Ethernet addresses. For the communication, a communication channel 
has to be established that is defined by TSAPs. 
The Ethernet address has a length of 6Byte. The first three bytes define 
the manufacturer. These bytes are set by the IEEE comitee. The last 
three bytes are at your disposal. Within a network there must not be more 
than one station with the same Ethernet address. Within company 
systems, the Ethernet addresses are assigned central by the network 
administrator. 
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Parameter H1 datagramm connection 
 
Connection name 

 
You may assign a name for your connection. The length is up to 32 
characters. 
 

Page frame offset 
(SSNR) 

The page frame offset (SSNR-Offset) defines the offset to the basic 
interface number (Basis-SSNR). The basic interface number is given at 
initialization. At mono processor operation, the page frame offset has to 
be set at 0. At multi processor systems, the value is between 0 and 3. 
 
Please regard the following options:  
CPU 1 communicates via page frame 1 (Basis-SSNR+ SSNR-Offset 0) 
CPU 2 communicates via page frame 2 (Basis-SSNR+ SSNR-Offset 1) 
CPU 3 communicates via page frame 3 (Basis-SSNR+ SSNR-Offset 2) 
CPU 4 communicates via page frame 4 (Basis-SSNR+ SSNR-Offset 3) 
 
Value range: 0 to 3 
 

Order number 
(ANR) 

Every connection that will be called by a PLC handling block needs an 
order number. Together with the page frame offset, the PLC program is 
able to call the connection. Thus, an order number must not exist twice 
and causes an error warning at parameterization in WinNCS. Within the 
control program, the order number (ANR) is given to a PLC handling block 
together with the page frame offset number (SSNR). 
 
Value range: 1 to 199 
 

Priority This parameter sets the priority of the telegram on the CP. The priority 
may range between 0 (highest priority) to 1 (lowest priority). 
Connections with the priorities 0 and 1 are –seen from connection link-up– 
so called static connections, i.e. after a connection termination (evtl. 
initialized by a reset handling block) the connection establishing is retried. 
 
Value range: 0 to 1 
 

Order type Choose the order type. The following order types are available: 
 
Send Directly:   Send unstructured data. 
Receive Directly:   Receive unstructured data. 
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Type Type sets the type for the transfer. You may send unsecure telegrams to 
a certain receiver, to chooseable receiver groups or to all receivers.  
 

Single order Unsecure order for one station. 
 

Multicast Unsecure order for chosen multicast circles. 
As soon as you choose multicast, the multicast-ID is set as Ethernet 
address. Multicast circles are defined via the last three nibbles of the 
Ethernet address. 
 

Broadcast Relation free sending of single messages to all partners connected via the 
broadcast address res. reception of single messages coming in via the 
broadcast address.  
The broadcast address with H1 is FFFFFFFFFFFFh.  
 

Foreign address 
(Adr) 

Here you type the address of the partner station that will communicate 
with this connection. The partner station has to be addressed with an 
Ethernet address. The Ethernet address must be unique within the 
network. 
The Ethernet address has a length of 6Byte. The first three bytes define 
the manufacturer. These bytes are set by the IEEE comitee. The last 
three bytes are at your disposal. Within company systems, the Ethernet 
addresses are assigned central by the network administrator. 
Broadcast telegrams don't need an Ethernet address. 
 

Transport Service 
Access Point 
(TSAP) 

Via TSAPs connection channels for a connection are build-up with H1. 
The length of a TSAP is between 1 and 8Byte. The assignment may be in 
Hex or ASCII format. TSAPs are also necessary for broadcast telegrams). 
To simplify the procedure, you may set the same ID for the own and the 
foreign TSAP. 
 

Local TSAP 
 

This is the TSAP of the own (local) station. 
 

Local TSAP length 
 

Sets the length of the local TSAP in Byte.  

Foreign TSAP 
 

This is the TSAP of the destination station (foreign station). 
 

Foreign TSAP 
length 
 

Sets the length of the foreign TSAP in Byte.  
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CP online functions 

Overview 

  
Under the online functions WinNCS provides functions for the online 
access to your CP. 

Via Online > Online functions or via , you may activate res. 
deactivate the online functions.  
The buttons of the online functions appear as symbol bar in the lower part 
of the main window.  

 
 
Basic online 
functions 

 
The basic online functions are the connection establishment, the status 
processing and request. These functions are activated by clicking on the 
Offline/Online symbol and the symbol bar appears.  
 

Preconditions Some preconditions have to be fulfilled for the online functions. The 
following picture illustrates the relations:  

 Init

Ping Connect

CP state Run Stop

CP < PC

CP > PC

 
  

Like to see in the picture, all online functions require an initialization of the 
destination module. For a status change (RUN/STOP) res. status request 
also a connection is required.  
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Online functions 

 

  

 
Via Online > Online functions or the according button, you may activate 
res. deactivate the online functions.  
The buttons of the online functions appear as symbol bar in the lower part 
of the main window.  
 

 
Initialize CP  

  

Presetting of the protocol type and station address.  
The IP address is taken over into the Init-Dialog as soon as an online 
function is executed.  
 

 
 

Establish 
connection 

  

Establishes a connection between your PC and CP. The communication 
parameters given under Init are used. 
An online connection is the precondition for the following functions.  
 
 

Start CP 

  

Sets your CP into RUN state (Software-RUN). The RUN/STOP lever of 
the CP has to be in RUN position. 
 

Stop CP  

  

Sets your CP into STOP state (Software-STOP), even if the RUN/STOP 
lever of the CP is in position RUN. Before transferring a project into your 
CP, the CP has to be set into Software-STOP.  
 

  
This function shows the current operating state (RUN/STOP) of the CP in 
the status bar of the main window.  
 

  
If your CP is in (Software-)STOP you may transfer your project to the CP 
by means of this button.  
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This function imports the project engineering from the PC into WinNCS. 
 

  
This function transfers your project from the CP-RAM into the internal 
Flash-ROM. Depending on the deployed CP, this function is required after 
the project transfer. For detailed information please refer to the 
documentation of your CP. 
 

  
This button executes an overall reset on your CP. The overall reset sets 
the CP back into delivery state. The project is deleted and the original IP 
address is reassigned. 
Before the overall reset, the CP has to be set into STOP. After the overall 
reset, the CP has to reboot. Switch the voltage supply of the CP off  and 
on again.  
 

 
The Identification mask monitors all parameters that identify the CP 
unambiguously. All parameters of this screen are only for control 
purposes and may not be altered.  
 

 
This button opens a window with a list of the indicator words from 0 to 
223. The indicator words are monitored as Byte in hexadecimal form.  
The indicator word with the order number 0 has an extra meaning. The 
order number 0 contains the order number that is currently processed in 
the module by SEND ALL res. RECEIVE ALL. 
 

 
Monitors the sum state of all connections. 

 
Monitors the sum state of all H1 transport connections 

 
Monitors the sum state of all H1 datagram connections 

 
Monitors the sum state of all TCP connections 

 
 

Monitors the sum state of all UDP connections 

 
After a click on the button Status and Control, an operand table opens. 
Enter the operands you want to visualize res. alter.  
As soon as the connection to the destination station is established, 
WinNCS sets the format for the operands automatically and transfers the 
status values to the monitor.  
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Initialize protocol/address  

 

  

 
As basic precondition for the online functions you have to initialize the 
destination module. At Initialization you set the destination module and the 
transfer type. You can call the destination device serial or online via the 
network. For this you need protocol parameters.  
The functions for the module transfer and the status functions need the 
following parameters:  
 

  

 
 

IP address This address is the IP address of the CP that is the communication 
partner at the online functions.  
 

Protocol You may choose between IP protocol, Serial-CP143, Serial-CP443, H1 
protocol and Serial-H1.  
 

Symbol manager 

  

The symbol manager allows you to assign symbolic names for Ethernet 
and IP addresses. 
If you've activated the symbolic addressing, everywhere in the program 
the symbolic names appear where otherwise the absolute addresses 
would be. 

The ping function  in the symbol manager allows you to detect wether 
the destination module is physically at the network and answers the ICMP 
message send by the ping.  
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Deployment of the symbol manager 

 
Edit > 
Symbolism 

 

 
The symbol manager is only available with the Ethernet functionality. The 
symbol manager allows you to assign symbolic names to your Ethernet 
and IP addresses. 
 

 
The symbolic names are available in the selection lists of WinNCS where 
addresses are assigned.  
 

Name is limited to 
20 characters 

A name has the maximum length of 20 characters. Other conventions do 
not exist.  
 

    

Double assigned names for Ethernet res. IP addresses are recognized at 
translation and monitored.  
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Activation The activation happens via the tick box "Symbolic display". 
 

 
 
If you've activated the symbolic addressing, everywhere in the program 
the symbolic names appear where otherwise the absolute addresses 
would be.  
If an absolute address has no assigned symbolic address, the absolute 
one is used. The comment appears only in the symbol manager.  
 

Sort options For a better overview you may sort the list after absolute addresses or 
after symbolic names.  
The sorting can be switched off via None. 
 

 
Load res. open 
symbol file  

   

Please regard that the symbol list is not stored together with the project. A 
created symbol list can be stored under a file name. A stored symbol list 
can be loaded into the symbol manager with the load function.  
At a program restart, the latest symbol list is automatically loaded.  
 

Ping function 

 

The ping function allows you to proof if the destination device is physically 
connected to the network.  
Set the focus on the wanted IP address in the symbol table. 
With a ping, an ICMP message is send to the destination device. Within a 
certain reaction time, the module answers and the result is shown as text. 
If ping has been successful, the message "Ping-Echo in n ms" is 
monitored otherwise an error message occurs.  
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Preconditions The ping function needs the following conditions: 

• The destination device is initialized via . 

•  is not active 
• the IP protocol is set 
• the destination device has been booted, the state is RUN or STOP 
 

OK, Cancel After a click on [OK], the lists are confirmed and in case of invalid or 
double symbolic names, a message window appears. With [Cancel] all 
alterations and the automatically entered addresses are lost.  
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Establish an online connection  

 
Precondition 
initialization 

 

 
As basic precondition for the online functions you have to initialize the 
destination module. At Initialization you set the destination module and the 
transfer type. You can call the destination device serial or online via the 
network. For this you need protocol parameters.  
 

 
 

Establish 
connection 

  

This button establishes a connection to the CP selected under . As 
soon as the connection is established, you gain access to the CP via the 
online functions.  

Another click on  and the connection is terminated again. 

The result of the connection initialization is shown via .  
An online connection is the precondition for the following functions.  
 

Monitor CP 
operating state 

  

This button monitors the current operating state of the CP (RUN/STOP) in 
the status bar of the main window.  
 
 

Change operating 
state 

To change the operating state, please use the following buttons: 
 

Stop CP  

  

Sets your CP into STOP state (Software-STOP), even if the RUN/STOP 
lever of the CP is in position RUN. Before transferring a project into your 
CP, the CP has to be set into Software-STOP.  
 

Start CP 

  

Sets your CP into RUN state (Software-RUN). The RUN/STOP lever of 
the CP has to be in RUN position. The CP reboots and the connection 
between PC and CP is terminated. The CP needs app. 10 seconds until 
ready again, i.e. the RUN-LED is on. For a new communication, the 
connection has to be established again.  
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Transfer and delete a project engineering 

 
Precondition 
initialization 

 

 
As basic precondition for the online functions you have to initialize the 
destination module. At Initialization you set the destination module and the 
transfer type. 
 

Import project  
into PC 

  

This function imports a project engineering from a CP into WinNCS. For 
this you select a file name in the file selection window. Regardless of the 
CP state, the data is stored at the hard disc. 
 

Transfer project 
into CP  

  

Transfer your project into a CP. You have to set the CP in STOP state first 

via . Select the according file name in the file selection window. After 

the successful transfer you reboot the CP with . After a 
synchronization time of app. 10 seconds, the CP reboots with the new 
parameters.  
If the new data changed the address of the CP, you have to tell this at the 
next connection attempt. 
 

Transfer project 
into Flash-ROM  

  
 

Some CPs require a "Flashing" after the project engineering. Here the 
current CP project is copied from the CP-RAM in the internal CP-Flash-
ROM. For detailed information refer to the CP manual. 
 

Overall_Reset of  
the CP 

 
 

This button initializes the overall reset of the CP. The project on the CP is 
deleted and the CP is set back to the original IP address. For an overall 
reset, the CP has to be in STOP. 
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CP diagnosis 

Overview 
  

WinNCS has got a wide range of CP diagnosis options. 
 

 
 

Monitors all parameters that identify a CP unambiguous like 
address, serial number and firmware. 

 
 

Displays the indicator word states of the CP 

 
 

Monitors the sum state of all connections 

 
 

Monitors the sum state of all TCP connections 

 
 

Monitors the sum state of all UDP connections 

 
 

Monitors the sum state of all H1 transport connections 

 
 

Monitors the sum state of all H1 datagram connections 
 

 

Identification 
 

 
 
 

 

A click on  opened the "Identification" window. Monitors all 
parameters that identify a CP unambiguously. All parameters of this 
screen are only for control purposes and can not be altered.  
Shown are station name, Ethernet and IP address, subnet mask, serial 
number and firmware version. 
Additionally, "Local" gives you information about your PC like user name, 
computer name and IP address. 
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Parameter  
  
Station Name of the according station that you've assigned at the initialization of 

the CP. If no database is loaded in the module, no name is shown.  
 

Ethernet address Ethernet address of the module that you may assign res. alter at the 
initialization of the CP. If no database is loaded in the module, the original 
Ethernet address is shown. 
 

IP address IP address of the module that you may assign res. alter at the initialization 
of the CP. If no database is loaded in the module, the IP address is 
calculated from the Ethernet address and shown.  
 

Subnet mask Subnet mask for IP addresses that you may assign at the initialization of 
the CP.  
 

Serial number Serial number of the module, the value is not alterable in WinNCS. 
 

Firmware version Version of the firmware in the module. The value is not alterable in 
WinNCS. 
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Indicator words 
 

 

 

When you click on , the window "Indicator words" opens. The 
indicator words of the orders 0 to 233 are listed as Byte in hexadecimal 
form.  
  

 

 
 

 
Please regard that the indicator word with the order number 0 has an 
extra meaning. The order number 0 contains the order number that is 
currently processed in the module by SEND ALL res. RECEIVE ALL. 

When you click on , the display is cyclically updated and the states of 
all indicator words are started res. stopped. The button serves as on/off 
switch.  

If the status has been stopped,  gives you the opportunity to update 
the display for one time.  

The interface number (SSNR)  can be 
switched in the range of [0..3] at any time if supported. 
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Important indicator 
words 

FAh The error ID "F" tells that the according order is not defined in the 
CP. The status ID A shows that the order is blocked (for 
SEND/FETCH and RECEIVE). 

 AAh The error ID "A" shows that the connection of the order is not res. 
not yet established. The status ID "A" blocks SEND, RECEIVE and 
FETCH.  

 08h The connection is reestablished (e.g. after a CP reboot), the SEND 
is released (SEND communication order).  

 09h The connection is reestablished (e.g. after a CP reboot), the 
RECEIVE is released (RECEIVE communication order).  

 04h SEND is successfully finished, data has been transferred. 
 02h The SEND, RECEIVE, READ res. WRITE order is in progress. At 

SEND the partner is not yet ready for RECEIVE, at RECEIVE the 
partner has not yet given a SEND.  

 05h RECEIVE is successfully finished, the data has arrived at the 
control.  
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Status monitor of connections 
 

 
 

 

Via  you reach information about all configured connections of a CP 
and their status and error messages.  

With a click on , the states of all connections are monitored. The 
button serves as on/off switch.  
If the protocolling has been stopped, you may update the display for one 

time with . 
To monitor a connection, you may display its state in a separate "Trace" 

window with  and update it with . 

Detailed information about a connection appears with .  
The functions "Detail" and "Trace" influence the runtime/performance of 
your connections!  
 

    

Note! 
Please regard that not all CPs support the sum state display. For the 
status monitor of a special connection type, click on the according 
connection type. The dialog windows for the sum state of a connection 
type have the same structure like the dialog window of the sum state of all 
connections.  
  

 
 

Monitors the sum state of all TCP connections 

 
 

Monitors the sum state of all UDP connections 

 
 

Monitors the sum state of all H1 transport connections 

 
 

Monitors the sum state of all H1 datagram connections 
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Column headlines 
 

 

Pos Position of the connection in the list 
SSNR Number of the page frame where a connection is running. 
ANR Order number of the connection 
V-Status Status of the connection 
V-ID Internal connection number that is used by the system. 
A-Art Shows the order type: SEND, RECEIVE, READ ACTIVE (PASSIVE), 

WRITE ACTIVE (PASSIVE). 
A-Status Monitors the status of the order processing.  
A-Error Errors during order processing. 
Aend Status changes are marked with a "*". 
  
Symbols 
 

 

 
The status output of all connections is activated res. deactivated. The 
status key has a LED monitor as indicator for the cyclic status update. 
When you highlighted a connection, only the state of this is shown. The 
mark is set in the first column with mouse or cursor. The > character 
stands for a marked connection.  
 

 
Momentary status, the connection data is updated once.  
 

 
You reach the single status of the connection that you selected in the sum 
state.  
 

 
You reach the trace status of the connection that you selected in the sum 
state. 

CLR All highlights in the sum state window are deleted.  
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Important status and error messages of the status functions 
 
V-Status 

 
V-Status shows the state of a connection. 

 Code Description 
 X000h Initialization is running 
 X100h Connection establishment is running 
 X101h Connection establishment is running again 
 X300h Connection established 
 X500h Connection termination local 
 X501h Connection termination from partner 
 XF00h Connection error 
 X: 0=active; 1=passive; 2=dynamic  

 
A-Status The A-Status shows the state of the order processing. 
 Code Description 
 0000h No order processing at this time 
 0020h Data to foreign station 
 0021h Data from foreign station 
 0022h Wait for SEND acknowledgement 
 0023h Wait for data from foreign station 
 0024h Local SEND acknowledgement 
 0040h SEND-DIRECT received from control 
 0048h Wait for SEND-ALL call 
 004Ah SEND-ALL data received 
 0050h Wait for RECEIVE-DIRECT call 
 0052h Acknowledgement from RECEIVE-DIRECT received 
 0058h Wait for RECEIVE-ALL call 
 005Ah RECEIVE-ALL acknowledgement received 
 0060h FETCH-DIRECT received from control 
   
A-Error 
 

Here the errors are monitored that occured during error processing. The 
following error messages are defined: 

 Code Description 
 00h No error 

If the Bit "Order ready with error" is set, the CP had to reestablish 
the connection like e.g. after a reboot or RESET 

 01h Wrong Q/ZTYP at the handling block 
The order is parameterized with wrong TYPE-ID. 

 02h Area not present in CPU 
The order call used the wrong DBNR. 

 03h Area in CPU to small 
The sum of Q/ZANF and Q/ZLAE exceeds the area limits. At 
DBs, the limit is set by the block size, otherwise the size depends 
on the CPU type. 
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 04h QVZ error in CPU 
The source res. destination parameter points to an area of the 
CPU with defective or not available memory. The QVZ error only 
occurs with Q/ZTYPE AS, PB, QB or memory failures. 

 05h Error in the indicator word 
The parameterized indicator word can not be processed. This 
error occurs if you set ANZW as data word res. double word that 
is not or not longer in the specified data block, i.e. DB too small 
or nor present. 

 06h No valid ORG format 
The data destination res. source is neither in the handling block 
(Q/TYP="NN") nor in the connection block. 

 07h Reserved 
 08h No free transport connections 

The capacity of the transport connections is exceeded. Delete 
not necessary connections.  

 09h Remote error 
An error occurred in the communication partner at a 
READ/WRITE order. 

 0Ah Connection error 
The connection for an order is not res. not yet established. The 
error stops as soon as a connection is established. If all 
connections of the CP are terminated, an error in the module or 
the bus cable may be the cause. Another reason could be a 
wrong parameterization.  

 0Bh Handshake error 
This may be a system error or the data block size is too large.  

 0Ch Initialization error 
A wrong handling block or an oversized data block has been 
used at initialization.   

 0Dh Cancel after RESET 
This is an operation message. At priority 1 and 2, the connection 
is terminated and established again as soon as the communica-
tion partner is ready for a new connection. At priority 3, the 
connection is deleted, a new initialization is possible.  

 0Eh Order with basic load function 
This is an operation message. The order is a READ/ 
WRITE-PASSIVE and can not be started from the automation 
device. 

 0Fh Order not present 
The called order is not engineered on the CP.  
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Single status 
 

 
 

 
For a chosen connection from the sum status list the status and error 
messages are monitored. If you break the up date you reach a mode 
where you can work through the communication of the connection step by 

step by clicking on . The upper part of the window shows port and IP 
address at TCP/UDP connections and Ethernet address and TSAP at H1 
transport and datagram connections.   
 

 
Row headlines 
 

 

A-Type Shows the order type: SEND, RECEIVE, READ ACTIVE (PASSIVE), 
WRITE ACTIVE (PASSIVE). 

A-Status Status of the order processing 
A-Error Errors during order processing 
V-Status Status of the connection 
V-Id Internal connection number used by the system  
Data Netto data (max. 32Bytes are shown)  
  
Symbols 
 

 

 
The Status monitor of a connection is activated res. deactivated. The 
activation influences the runtime behavior of your connections.  
 

 
The connection data is updated once.  
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Trace status 

 

 

 
For a connection from the sum status list, the status and error messages 
are shown. The list is able to monitor the last 200 telegrams of a 
connection. With more messages, the oldest telegrams are overwritten. 
When you break the status, you can walk through the list.  
 

  
Column headlines 
 

 

Pos Position of the telegram in the list 
V-Status Status of the connection 
V-ID Internal connection number used by the system 
A-Status Status of the order processing  
A-Error Errors during order processing  
Data Netto data (max. 32Bytes are shown)  
  
Buttons/Symbols 
 

 

  
The Status monitor of a connection is activated res. deactivated. The 
activation influences the runtime behavior of your connections. 

Dec/Hex The data can be monitored in hexadecimal or ASCII format. 
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Status and Control 
 

 

 
A click on the Button Status and Control opens an operand table. Enter 
the operands you want to visualize res. alter.  
As soon as you've established a connection to the destination station via 

, WinNCS sets automatically the operand format and transfers the 
status values to the monitor.  
Via "Control value" you may preset a control value. A doubleclick marks 
the value in blue for transfer.  
To transfer marked control values, start again the status processing via 

 or click on  during status processing. 

With  you may store the operand table and load it to WinNCS via .
The sequence counter "Seq" shows changes as Modulo 255 value 
(0...255). The sequence counter allows you to control the incoming 
telegrams with a network analyzer. Every change of an operand value is 
verified by a time stamp. 
 

 
Column headlines 
 

 

Operand Operand from the control 
Format All valid formats 
Status value Monitored status value 
Control value Defineable control value 
Seq Sequence counter showing changes  
Time stamp Time of the last alteration 
Comment Operand comment 
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Symbols 
 

 

 
Connect with the CP 
 

 
Start of the status processing, transfer of marked control values during 
status processing 
 

 
Alter (control) a value in the control via transfer of  marked control values 
during status processing 
 

 
Load an operand table 
 

 
Save an operand table. A stored operand table is automatically loaded at 
a reboot of WinNCS and linked to the original button if it is activated.   
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WinNCS for Ethernet coupler 

Outline 

 
General 

 
The "Ethernet" functionality allows to configure Ethernet couplers. 
The project engineering includes the Ethernet coupler and the connected 
modules.  
 

Engineering options WinNCS supports the following engineering options: 
• Project engineering online 

Starting with version 3.12, WinNCS is able to search stations in the 
Ethernet and to import their project engineering. 
A click on [Search slaves] lists all Ethernet coupler that are within the 
network and a double click on the wanted one imports it into WinNCS. 
Here you may work on the project engineering online and transfer the 
project to the Ethernet coupler via [Apply]. 

 
• Project engineering offline 

You engineer your slave offline and transfer your project with the 
integrated download function of WinNCS. 

 
Access mechanism The access happens via Port 5048 to the configuration server of the 

Ethernet coupler. 
The configuration server evaluates the number of connected modules, 
their address and parameter areas and offers these information to 
WinNCS under its IP address. 
WinNCS searches all couplers (slaves) of the network per broadcast. The 
network is searched up to the gateway.  
With this data, WinNCS creates a symbolic network and monitors it in its 
"network" window. 
Here you can assign real module types to the symbolic network online 
and with password and where applicable parameterize them.  
 

Integrated Browser 
function 

Via the integrated "Browser" function you may gain access to the website 
of the Ethernet coupler. 
The look of the website can be configured in WinNCS. 
 

Firmware update 
online 

You may online assign an IP address to the Ethernet coupler and update 
the firmware. 
All altering accesses are password protected. The password is requested 
once per session and slave.  
In delivery state, the Password is 00000000 (8xZero) 
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Fast introduction WinNCS for Ethernet coupler 

 
Preconditions 

 
For the project engineering, the following preconditions should be fulfilled: 
• Recent GSD for the Ethernet coupler is stored in the GSD directory of 

WinNCS. 
For the project engineering of the modules in WinNCS, the properties 
of the components are delivered in a GSD-file.  
Copy the GSD-file in the GSD directory of WinNCS. 

• For the online engineering, the Ethernet coupler should be built-up with 
the according modules, connected to Ethernet and supplied with 
voltage. 

 

    
 

Attention! 
For every Ethernet coupler is delivered with the IP address 10.0.0.1, you 
must not install more than one new Ethernet coupler at a time! 
 

Approach of the 
online project 
engineering 

• Start WinNCS. 

• By clicking on , you select the functionality "Ethernet". 
• Create a project with the function group "Ethernet" via 

File > Create/Open project. 
• >>A parameter window for the online search of "slaves" and "stations" 

opens. [Search slaves] lists all Ethernet coupler and [Search stations] 
all CPs auf. 

• Click on [Search slaves]  
>> All Ethernet coupler are searched and listed with IP address and 
occ. symbolic name. 

• A double click on a slave transfers it to the "network" window and lists it 
with the I/O periphery. 
>> If there is no parameterization yet, the modules are listed symbolic 
without label.  

• For every Ethernet coupler is delivered with the IP address 10.0.0.1, 
you should first assign a network address valid in your company net to 
the Ethernet coupler. Herefore you mark the Ethernet coupler and type 
the IP address and Subnet Mask in the "Parameter" window under the 
register "network" area TCP/IP.  

• Click on [Apply]. When asked for the password, type 00000000 
(8xzero), if you didn't change it yet. 
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 • Assign the according module type to the module symbol in the 

"Parameter" window and occ. set parameters. The according address 
area that a module occupies in the TCP data stream is automatically 
set by the Ethernet coupler.  

• As soon as you click on [Apply], a password request takes place. The 
password request is once per session and coupler. Give the correct 
password. In delivery state, the password is 00000000. When the 
password is valid, the data is transferred online to the Ethernet coupler. 
Repeat this for all listed modules.  

• Save your project. 
 

    

Note! 
Before having access to the Ethernet slave via your Internet browser, you 
have to assign a company valid IP address. You can do this like described 
above, online from WinNCS.  
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Create res. import an Ethernet project 

 
Create new Ethernet 
project  
 
 
 

 
Start WinNCS. 

 
Functionality 
Ethernet 

 
 

By clicking on , you set the functionality "Ethernet". 
 

File > Create/Open 
project 

 

Create a new project with the function group "Ethernet" via File > 
Create/Open project. 
You get a file selection window where you can type a name for your 
project file. If you type the name of an already existing file it will be 
opened.   
The project files of WinNCS have "vpr" as extension. The file names of 
the four last opened projects are listed in the file menu and can be 
opened directly.  
As soon as you confirm your entries, the "network" window with the 
concerning "parameter" window appears. 
The "network" window shows your new Ethernet net. Additionally to the 
"network" window, the "parameter" window opens. The "parameter" 
window serves the parameter setting for the elements of the "network" 
window. For example you may here assign a symbolic name for the 
network that is then used in the "network" window. 
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Search and import 
an Ethernet project  

Starting with WinNCS version V3.12, you have the possibility to search 
stations in the Ethernet and import their project engineering.  
By means of a click on the Ethernet level, you reach the "parameter" 
window with the search functions. 

  

 
The search supports the following systems: 
[Search slaves]  Search all Ethernet coupler 
[Search stations]  Search all Ethernet-CPs 
 
A click on [Search slaves] starts the search for all Ethernet coupler in the 
network. 
The available couplers are listed. Via double click you import the project of 
the current station and monitor it in the "network" window for further 
configuration. 
 

    

The online search is for the complete network up to the gateway.  
All listed Ethernet coupler may be engineered online.  
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Add an Ethernet 
network 

Via a click on  in the "network" window, you may add more 
networks with the selected "Ethernet" functionality at any time.  
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Alter an Ethernet project 

 
Preparation 

 
Load the project you want to alter or create a new one.  
As soon as you've loaded res. opened your project this is monitored in the 
"network" window with according "parameter" window. 
Starting from a network symbol that shows the functionality, the "Ethernet" 
functionality allows you to set stations, connections or modules and to 
parameterize them in the concerning "parameter" window.  
 

Difference between 
Ethernet coupler 
and Ethernet-CP 

WinNCS separates the following groups that can be engineered:  
• Ethernet coupler res. slave IM 253NET 
• Ethernet-CP stations and CPUs with CP portion 
The combination of both groups is not possible but you may create one 
network for every group within a project.  
 

 
 
In basic, both groups are engineered identically. 
 

Online project 
engineering 

For the online project engineering click on [Search slaves] in the 
"parameter" window. WinNCS now searches all coupler of the network by 
broadcast. The network is searched up to the gateway. The found 
couplers are listed in the "parameter" window with IP address. Via double 
click on the wanted coupler in the list, the coupler evaluates the number of 
connected modules, their address and parameter area and delivers this 
information via Port 5048 under its IP address to WinNCS. 
WinNCS creates a symbolic network and monitors it in its "network" 
window. For marking the online status, the network symbol for the 
Ethernet coupler is green colored. 
Depending on the mark in the "network" window, you may parameterize 
the coupler in the "parameter" window (password required) res. assign 
real module types to the module symbols in the "network" window and 
parameterize them.  
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Online 
parameterization of 
the Ethernet 
coupler 

• Mark the Ethernet coupler  
• Assign a convenient name to the coupler under "System". 
• Type the address data into "network". 
• Choose a new password in "Password" if wanted. For this you need 

the original password.  
In delivery state, the password is 00000000 (8xzero). 

• Configure the website of the coupler under "Properties". 
 
After you made all entries, you may transfer the parameters online to the 
Ethernet coupler via [Apply]. 
 

    

Note! 
You may only return to the "network" window when you confirm your 
entries via [Apply]. When you click on [Cancel], your station is deleted res. 
your entries are.  
 

Offline project 
engineering 

Another less convenient method is the offline project engineering. The 
following steps have to be executed: 

• Click on  to add an Ethernet coupler. 
• Assign a convenient name to the coupler under "System". 
• Type the address data into "network". 
• Configure the website of the coupler under "Properties". 
  
As soon as the Ethernet coupler is at the network, you may transfer the 
data online via the register "Download", giving the destination IP address 
and password. 
  

    

Note! 
Before a download you should confirm your entries for the project 
engineering once with [Apply], because the download fetches the 
database. 
You may only return to the "network" window when you confirm your 
entries via [Apply]. When you click on [Cancel], your station is deleted res. 
your entries are.  
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Parameterize Ethernet coupler  

Parameter for Ethernet 

Register Function group 
  

 
 
Name 

 
Here you may assign a name for your function group (max. 32 
characters). The name is for a better overview. There are no restrictions 
for the name but it is urgently advised to use unambiguous names for 
function groups.  
As soon as you [Apply] your entries, the name is taken over and shown in 
the "network" window. 
 

 
Search all Ethernet coupler 
 

 
Search all Ethernet-CPs 
 
A click on a search button starts the search for all available stations res. 
Ethernet coupler in the net. 
Available stations are listed. Via double click on the wanted station, the 
according project is imported and monitored in the "network" window for 
further parameterization. 
 

     

The online search is for the complete network up to the gateway. All 
available Ethernet couplers may be engineered online.  
With CPs you have to take care that the project engineering computer is 
within the same IP circle like the CP. 
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Parameter for Ethernet coupler 

 

 
You reach the "parameter" window by clicking on an Ethernet coupler in 
the network list res. by importing a project engineering via online access 
and [Search slave]. 
The "parameter" window contains the following registers: 
• System (Name assignment with short description) 
• Network (basic initialization of the Ethernet coupler) 
• Properties (Activation of the server on the Ethernet coupler) 
• Download (Download option for the project engineering) 
 

 

 
 

 At online access you have additionally this registers: 
• Password (Password for online access like project engineering, 

firmware update and reboot) 
• Firmware (Online firmware update after password request) 
• Reboot (Online reboot after password request) 
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Register System 
  

 
 

Name Here you may assign a name for the Ethernet coupler also referred to as 
"slave". 
 

Description Here you may type a description for the Ethernet coupler. 
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Starts your standard web browser and contacts the web server of the 
Ethernet coupler that you have to address before via the IP address in the 
register "Network". 
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Register Network 
  

This register manages the basic initialization of your Ethernet coupler. 
Here you parameterize and monitor the addresses and identification 
parameters of the coupler. 
 

 

 
 

Ethernet MAC address 
Inside the Ethernet, every participant can be identified unambiguously via 
a MAC address (Ethernet address). During online operation, the Ethernet 
address of the coupler addressed by the IP address is shown. 
 

 Link Speed, Duplex Mode 
Link Speed and Duplex Mode are reserved for later extensions. Both 
parameters are set to "Auto Mode" and must not be altered.  
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TCP/IP IP address 
Type here the IP address of your Ethernet coupler. More detailed 
information is in the description of your Ethernet coupler. 
The IP address is a 32Bit address that must be unique within the network. 
The address consists of 4 numbers separated by dots.  
 

 To build up private IP networks within the internet, RFC 1597/1918 
defines the following address ranges: 

 
 Class A: 10.0.0.0 ... 10.255.255.255 
 Class B: 172.16.0.0 ... 172.31.255.255 
 Class C: 192.168.0.0 ... 192.168.255.255 

 
 The IP address is necessary for the TCP/IP communication. You’ll get it 

from your system operator.  
  
 Subnet Mask 

The IP subnet mask is a 32Bit filter mask for IP addresses. Deploying 
subnet masks, you build up subnets by definition of IP number circles. 
Subnetworks need a router to communicate with each other. 
The addresses used for subnet masks have the same structure and value 
range than the IP address.  
 

    

Note! 
In opposite to the online CP access, the online access to an Ethernet 
coupler doesn’t need an IP circle adjustment at the PC. The access from 
the PC to the Ethernet coupler happens by means of UDP. 
 

 Default Gateway 
This field serves for further extensions and is not supported at this time.  
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Register Settings 
  

This dialog window allows you to configure the website of the Ethernet 
coupler. With a click on the tick boxes, the according element is monitored 
at the Ethernet coupler website or not.  
 

 

 
 

Webserver 
Configuration 

Enable HTTP Server 
If this option is activated, you may access the Ethernet coupler via a web 
browser. 
 

 Enable HTTP Set Outputs 
When activated, you may set outputs from the website.  
 

 Enable HTTP Set Parameter 
This allows you to monitor/hide the parameter area at the website.  
 

 Enable HTTP Reset 
Monitors/hides the "Reboot" and "Reset-Value" button on the website. 
 

 Enable HTTP Timeout 
When activated, you may set a timeout in ms via the website. By setting a 
timeout, you define the maximum time within a data communication must 
happen. If this time is exceeded, all connections are closed and the output 
of the connected modules are deactivated.  
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Register Download 
 

 

 
The download window allows you to send your offline engineered projects 
to the wanted IP address. This option required a password which is preset 
during online access in the register „Password“. 
 

 

 
 

IP address Type here the destination IP address of your Ethernet coupler.  
The IP address is a 32Bit address that has to be unique within the 
network. The address consists of 4 numbers separated by dots. 
Value range: 000.000.000.001 to 255.255.255.254 
 

Password The online project engineering requires a password that has to be preset 
online in the register password. 
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Register Password 
  

The different online access options to the Ethernet coupler are password 
protected. Every Ethernet coupler is delivered with the password 
00000000 (8xzero).  
This dialog window allows you to change the password. Enter the recent 
(old) password and twice the new one.   
A click on [Apply] transfers the new password online to the Ethernet 
coupler. 
 

 

 
 

Old Password Enter the recent valid password. Every Ethernet coupler is delivered with 
the password 00000000 (8xzero). 
 

New Password Type the new password for the Ethernet coupler. The password has to 
consist of exactly 8 characters. 
 

Repeat For confirmation of the password, type it a second time. 
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Register Firmware 
 

 

 
This register allows you to execute an online firmware update of the 
Ethernet coupler. 
As soon as you have given a firmware file and a valid password and click 
upon [Apply], the firmware is transferred online to the Ethernet coupler. 
This function is password protected. The password is preset in the 
register Password.  
 

 

 
 

Firmware 
Click on  and choose a valid firmware file. The firmware may only be 
transferred with a valid password.  
 

Password Type the valid password for the Ethernet coupler. The password in 
delivery state is to find in the description of your Ethernet coupler. 
The alteration happens in the register Password. 
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Register Reboot 
  

This register allows you to execute an online reboot of the Ethernet 
coupler. 
With a valid password and a click on [Apply], a reboot is executed at the 
Ethernet coupler. This function is password protected. The password is 
preset in the register Password.  
 

 

 
 

 The progress of the reboot is shown via a progress indicator. When the 
reboot is ready, there is an acknowledgement. 
  

 
 

Password Type the valid password for the Ethernet coupler. The password in 
delivery state is to find in the description of your Ethernet coupler. 
The alteration happens in the register Password. 
 

Reboot by [Apply] As soon as you click on [Apply], the Ethernet coupler executes a reboot. 
Reboot is only possible with valid password.  
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Project engineering of modules 

 
Preconditions 

 
You’ve built up an Ethernet network with at least one Ethernet coupler. 
For the project engineering of the modules, the performance 
specifications are delivered in form of a GSD-file.  
Copy the GSD-file in the GSD directory of WinNCS.  
For the online engineering, the Ethernet coupler should be built up with 
the according modules, connected to the Ethernet and supplied with 
voltage.  
 

Monitor module 
online  

With the data that WinNCS gets from the Ethernet coupler via [Search 
Slaves], WinNCS models a symbolic network and monitors it in its 
"network" window. For indicating the online state, the network symbol for 
the Ethernet coupler is colored in green. 
Depending on the mark in the "network" window, you may (password 
protected) assign real module types to the module symbols in the 
"network" window and parameterize them if wanted.  
 

Insert module 
offline 
 With marked Ethernet coupler, you may insert a new module via . 

 
Parameterize 
module 

For parameterization you click on your module in the "network" window. 
The parameters are entered in the "Parameter" window. 
 

 
 As soon as you assign the real module to the symbolic module via 

"Module type", all parameters for this module are listed. Confirm your 
entry with [Apply]. At online project engineering, the data is transferred to 
the coupler after a password request.  
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Parameterize modules 

Register Module configuration 

  
This dialog window allows you to enter module specific parameters. To 
reach this window, click on a module symbol in the "network" window or 

insert a new system 200V module via . 
 

 

 
 

 A parameter set e.g. for FM 254 is only shown for parameterizable 
modules. For control purposes you find the parameters as Hex value in 
the register "Module parameter". 
 

Module type WinNCS uses for the administration of the periphery a module file that is 
delivered with WinNCS. This file contains all module data for your 
Ethernet coupler. 
 

Parameter list With parameterizable modules, the lower part of the window shows a list 
of the adjustable parameters of the module. The information for that list 
comes from a module file that should always be up to date! 
As soon as you’ve set the according parameters and transferred them, all 
parameter are shown in the register "Module parameter" for control.  
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MAP Via [MAP] you can call a window that shows the address area occupancy 
of the Ethernet coupler. 
Here you may see for example, from which address offset on the in-
/output data of the module may be called.  
For in- and output area the window has one register each. 
The functionality in combination with the Ethernet coupler shall here be 
explained in a short example.  
 

 

1
2

 

[1] The address area of the marked 
module is shown in full color.  
For example, here the module maps 
its 8Byte input data starting with 
address 2. 
 
[2] The module that is the next one 
at the bus after the marked module 
creates 23Byte input data starting 
with address 10. 
 
 
 

Rules for automatic 
address allocation 

The address allocation (also called „Mapping“) happens automatically and 
can not be influenced.  
At start-up, the Ethernet coupler assigns automatically addresses to its in-
/output periphery, following this rules:  
• All modules are mapped from left (Ethernet coupler) to right in 

ascending sequence starting with address 0.  
• It is separated between in- and output area (e.g. if a module has in- 

and output data, they may be stored at different addresses). 
• A separation between digital and analog modules is not realized. The 

Ethernet coupler creates each a coherent area for in- and output data.  
 

     

Note! 
A description of the in- and output areas that a module occupies is to find 
in the description of the module.  
Please take care that modules that occupy more that 1Byte like e.g. 
analog modules are stored starting with an even address. Otherwise 
ModbusTCP causes problems at word accesses.  
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Register Module parameter 

  
The register „Module parameter“ is a monitor for controlling your 
parameters. This window allows no entries. 
 
 

 

 
 

The module parameters have the 
following structure: 
1st Byte Length definition 
2nd Byte Plug-in position 
 
Starting with Byte 3 the parameters 
that you’ve set via module configu-
ration are stored.  
 

Register Label 

  

 

 
This register allows you to superscribe 
module labels that can be printed. The 
label mask is free editable except of 
the module name.   
Entered inscriptions are stored after 
[Apply].  

Print label 

  

 

 
For printing the labels, you firstly have  
to activate „Labels“ under File > Print 
options. When you select File > Print, 
the label printout starts for all modules 
that are in the network of the recent 
CPU.  
The options "Detail view" and "Total 
network" have no influence on label 
printout.  
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Profibus functionality 

Overview 

 
Functionality 
"Profibus" 

 
With the functionality "Profibus" you may engineer your Profibus-DP 
master. Via the GSD-file that is available for every Profibus slave, your 
slaves are included in WinNCS and may be parameterized. 
 

Data transfer There are several possibilities to transfer data to your Profibus-DP master 
via the online functions: 
• Export your project as 2bf-file and transfer this via MMC into the DP 

master. 
• Export your project as 2bf-file and transfer this serial via Green Cable 

and the online functions into the DP master. 
• Transfer your project directly with a DP master PC plug-in module via 

Profibus into your DP master. 
 

 



Manual VIPA WinNCS Profibus functionality 

HB 91E - Rev. 04/03  137 

Fast introduction Profibus functionality 

 
Outline 

 
Under WinNCS you have the possibility to engineer your Profibus-DP 
masters. Export your project as 2bf-file. Transfer this onto MMC or via 
Green Cable and Profibus interface to the DP master. 
 

Steps of project 
engineering 

• Start WinNCS. 

• Choose the functionality "Profibus" with . 
• Create a new project with the function group „Profibus“ via File > Project 

set-up/open.  
• >> Now you reach the "Parameter" window "Function group". 
• Type a convenient name under "Function group" for your Profibus 

network and click on [Apply]. The bus parameters are only calculated 
after the complete configuration of the bus. 

• Add a new Profibus-DP master in the "network" window with . 
• Type Name, Profibus address etc. in the "Parameter" window and click 

on [Apply].  

• Add a Profibus slave in the "network" window with .  Type the 
Profibus address, the Family "I/O" and the Station type in the 
"Parameter" window and click on [Apply].  

• Engineer all peripheral modules connected via backplane bus to the 

Profibus slave by means of .  
• [Auto] allows you to address the periphery automatically and monitors 

the allocation via [MAP].  
 
Please take care that there are no conflicts between automatical address 
allocation and local periphery addresses! 
If you work on an intelligent module like e.g. the CP240, the concerning 
settable parameters appear.  
After having engineered all slaves with concerning periphery, you have to 
calculate the bus parameters for the Profibus.  
 
• For calculation of the bus parameters, activate the function group 

„Profibus“ in the "network" window. 
• Click on the register „Bus parameter“ in the "Parameter" window.  
• Set the wanted baudrate and click on [Calculate]. 
• >>  The bus parameters are calculated - [Apply] them.  

Every change in the module combination needs a new bus parameter 
calculation! 

• Activate the function group „Profibus“ in the "network" window and 
export your project into the file dpm.2bf. 
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Transfer options To transfer the 2bf-file, you have the following options: 
• Transfer via online functions and Green Cable 
• Transfer via MMC 
 

    

Attention! 
Please regard the hints for the deployment of the Green Cable in the 
description of your Profibus-DP master! 
 

RN
ST
MR

DP master

Green Cable

Power OnDP master

Power On

2

1

3

4

5

7

Power OffDP master

(serial, COM-No.)

2bf-Transfer into DP master

Transfer completed Power OffDP master

Connect PC and DP master via Green Cable

6

DP master

DP master

Profibus

Disconnect Green Cable and connect Profibus cable

8  

• Turn off the voltage supply of your DP master. 
• Connect your DP master with a COM interface of 

your PC by means of the Green Cable. 
 
• Please regard that not all DP masters are 

supporting the Green Cable. More detailed 
information is in the manual of your DP master. 

 
• Start WinNCS. 
• Set the functionality Profibus and activate the online 

functions with . 

• Click on  and set the communication parameters 
(Medium "Serial",  Interface no. "Nr. of your COM 
interface“) 

• Turn on the voltage supply of your DP master.  
>> Your DP master can now receive data serial via 
the Profibus interface. 

• Establish a connection between your PC and the 

Profibus-DP master via . Data can only be 
exchanged with an active connection.  

• With  you may now transfer your 2bf-file into 
your DP master.  

• Turn off the voltage supply of the DP master for a 
short time and set it to RUN at the Profibus.  
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Create new res. import a Profibus project 

 
Create new  
Profibus project 
 
 
 

 
Start WinNCS. 

 
Functionality 
Profibus 

 
 

By clicking on , you set the functionality "Profibus". 
 

File > Project set-
up/open 

 

Create a project with the function group „Profibus“ via File > Project set-
up/open. 
A file selection window appears where you can type a name for the 
project file. If you type the name of an already existing project, this is 
opened.  
The project file under WinNCS has "vpr" as extension. The file names of 
the last four opened projects are taken over into the menu File and may 
thus be opened directly. 
As soon as you confirm your entries, the "network" window with 
concerning "Parameter" window is opened. 
The "network" window shows your new Profibus net. In the "Parameter" 
window you may assign a symbolic name to the network. 

Click on  in the "network" window to add further networks with the 
selected "Profibus" functionality to your project.  
 

 

 
 
Additionally to the "network" window, the "Parameter" window appears. 
The "Parameter" window serves the parameter setting of the elements 
monitored in the "network" window. For example, you may here assign a 
symbolic name to the network that is used to list the Profibus network in 
the "network" window. 
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Import  
Profibus project  

Starting with WinNCS version V 3.12, you have the comfortable possibility 
to import a Profibus project from a DP master into WinNCS by using the 
online functions and the Green Cable. 
Connect the Profibus interface of your Profibus-DP master with the COM 
interface of your PC via Green Cable. 

Activate the online functions for Profibus via . 
 

 

Set the Medium „Serial“ and your PC interface under .  

With  a connection between PC and DP master is established. The 
communication parameters given under „Init“ are used.  

For the import, you click on . Choose a destination where the 
imported file has to be stored and start the import. The progress is shown 
with a progess indicator in the main window.  

After the data transfer you may import the file into WinNCS with . 
 

     

 
WinNCS uses for import and export 2bf-files. 
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Alter Profibus project and engineer DP master 

 
Preconditions 

 
Load a project to alter res. create a new Profibus project. 
As soon as the project is loaded res. created, it is opened in the "network" 
window with concerning "parameter" window. 
Starting with a network symbol that shows the functionality, the "Profibus" 
functionality allows you to place DP master, DP slaves or modules and to 
parameterize them in the concerning "Parameter" window.  
 

Project engineering Depending on the position in the network list, the upper part of the window 
shows symbols that are used to construct the network.  

Engineer a DP master by clicking on . 
Alter the wanted settings in the "Parameter" window.  
 

     

Note! 
Don’t miss to click on [Apply] to confirm your entries before returning to 
the network window. A click on [Cancel] deletes your DP master again. 
 

 If you now click on the DP master symbol in the "network" window, you 
can see the network elements available for the DP master. 
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Parameterize Profibus system  

Parameter Profibus network 

Register Function group 
 

 

 

 
 
Name 

 
Here you may assign a name for your function group (max. 32 
characters). The name serves the overview. There are no restrictions 
depending on the name but it is strongly recommended to use 
unambiguous names for function groups. 
As soon as you confirm your entry, the name is applied and shown in the 
"network" window. 
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Register Busparameter 
  

This dialog window serves the setting of the physical parameters of the 
Profibus. The here entered settings are valid for one complete bus.  
The calculation of the bus parameters is executed after the 
parameterization of master and slave modules. 
 

 
 

Bus description Assign a name to your configured bus (max. 32 characters). It is strongly 
recommended to use unambiguous names for the bus description. 
 

Baudrate You may set a value between 9.6 and 12000 kbit/s. 
 

T_qui Quiet time is the time that has to be considered at transformation of 
signals (NRZ) to other codings. The switching time for repeaters depends 
on the baudrate. It is: T_rdy > T_qui 
 

T_set Is the time between the last interrupt and the execution of the according 
reaction. The setup time is the shorter the higher the performance of the 
used bus ASIC and the connected processor. The value depends on the 
baudrate. 
 

T_slot is the max. time that the initializing system has to wait until the first 
character/sign is received. The value depends on the baudrate. 
 

HSA Shows the highest station address in the system. 
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Poll Timeout is the max. time after which the response in a master-master 
communication has to be requested from the repeater. 
 

Watch/TTR Fixes the factor of multiplication of the time TTR. 
 

Repeater on Bus Choose this option when repeaters are within your bus.  
 

Tsdr_min is the time that a slave has at least to wait until it is allowed to answer. 
 

Tsdr_max is the time after which a slave has to have answered.  
 

Retry Limit If a master doesn’t get an answer from a called slave, it repeats the call 
acc. to Retry Limit. Afterwards, the slave is provided in further bus cycles 
in slow poll in case of an error.  
 

Gap-Factor This factor gives the number of token circles after which every active 
station proofs the Profibus address lacks in its GAP. Profibus address 
lacks may occur for example by drop out of masters. 
 

Delta Ttr 
 

is the Delta-Target-Rotation-Time (additional scheduled token circle time). 
This is the time that has to be taken into account for other masters that 
are at the Profibus bus but are not part of the project engineering.  
 

Ttr Target-Rotation-Time (scheduled token circle time). This is the max. time 
for a token circle. The real time that the master has for sending data 
telegrams to the slaves depends on the difference between scheduled 
token circle time and real token circle time. 
 

WD Factor 1, WD 
Factor 2 

The two Watchdog factors depend on the baudrate and are used for the 
calculation of Data-Exchange. 
 

Watchdog At the call control, the master polls the slaves. Within the call control time, 
the master has to call the slave at least one time (token delivery) to reach 
the state "Data Exchange". 
 

T_rdy Ready-Time: This is the time that the master has to be ready for reception 
after it has called an acknowledgement or response.  
 

T_id2 Idle-Time 2 (resting time 2): This is the time that passes after the sender 
(initiator) sent a call telegram that is not acknowledged (SDN) as idle (= 
binary "1") on the bus before the first bit of a new telegram is send to the 
bus. Conditions: T_id2 >= T_id1 
 

T_id1 Idle-Time 1 (resting time 1):  
This is the time that passes at the sender (initiator) after the reception of 
the last bit of a telegram as idle (= binary "1") at the bus until the first bit of 
a new telegram is send to the bus. 
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Control time is calculated with WD 1 and WD 2 and passed on to the Profibus stack.  
 

Calculate This button starts the calculation of Ttr, WD Factor 1, WD Factor 2, 
Watchdog, T_rdy, T_id2, T_id1 and Control time. 
After the calculation, you may change the values. With [Apply] the values 
get valid. 
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Parameter DP master 

 
Register 
Master/Host 

 

 

You reach the "Parameter" window by clicking on  in the network 
list or by adding a new DP master.  
In this dialog window you type the parameters for your DP masters.  
 

 

 
 

Name Type the name of your master (max. 32 characters). The name serves the 
overview. There are no restrictions depending on the name but it is 
strongly recommended to use unambiguous names for function groups. 
As soon as you confirm your entry, the name is applied and shown in the 
"network" window. 
 

Profibus address Choose the Profibus address of the master module. 
 

Global watchdog When activated, the watchdog is active for all DP slaves of the master 
system. When a DP slave is not called within the calculated watchdog 
time, it is set in save state (all outputs are set to "0"). 
 

     

Attention! 
If you don’t activate a watchdog, in case of an error (Error from the master 
or interruption of data transfer at the bus) all outputs of the DP slave are 
not shut down. The outputs are not set to "0", i.e. the last received signal 
state of the output remains valid! 
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Start Delay Start delay allows you to set a time which the Profibus master has to wait 
with starting until the CPU has been booted. The time window is between 
21s and 1200s. If you enter 20, the delay time is 0.  
 

Error report mode When the master is assigned to a CPU, you may here select the behavior 
of the CPU at interruption of the bus communication to a slave (station 
failure). At the slave parameterization, you fix the slaves for reaction to a 
station failure.  
 
The option fields have the following meaning: 
 

none The CPU switches to RUN without delay also if not all slaves have 
acknowledged. 
 

QVZ Receipt confirmation delay happens when a master memory area misses 
to acknowledge a CPU call with a READY signal within a defined time.  
 

 Possible error causes: 
 - Error in the user application 
 - Slave is defect or missing 
 - Bus communication to the slave is interrupted 
  
PEU Periphery undefined is created when a slave error occurs and the slave 

can not be called by the master.  
 

Host station type At this time, the value is fix at "CPU2xx" without interfering other 
functions. In the future there will be other host types, too.  
 

Reserved I/O range You may reserve up to 4 address areas for each in- and outputs. These 
areas are protected at the automatic address allocation. 
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Map If you click on [Map], a window is opened that shows the occupancy of the 
peripheral address area. Here you may see for example, from which 
address offset on the in- res. output data of the chosen module is stored.  
For in- and output area, the window has each one register. 
 

 

3
4

1 2

5

6

[1] Each one register for in- and 
output area 
[2] Legend 
[3] reserved address area 
[4] Address area occupied by 
others than the chosen module 
(half-tone color). 
[5] Address area of the chosen 
module in full color 
[6] Not used address areas are 
shown in white 
 
 
 

 Profibus supports the following areas: 
 

    (red) Shows reserved address areas. 
You may reserve up to 4 address areas each for in- and 
outputs. These areas are protected at the automatic 
address allocation.  

    (blue) Address area occupied in the CPU by the modules 
connected via Profibus.  
 

Symbolic file Here you may choose a S5 symbol file from Siemens. As soon as you 
choose "active", the symbol comments of the symbol file are used for the 
labels. This must not be altered in WinNCS. Deactivating the symbol file 
keeps the symbol comments and they can be altered.  
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Project engineering DP slave 

 
Preconditions 

 
You’ve created a Profibus network with at least one DP master. 
For the project engineering of a slave system, the performance 
specifications are delivered in form of a GSD-file.  
Copy this GSD-file into the GSD directory of WinNCS. 
For the project engineering, the DP master has to be build-up with the 
according slaves, connected via Profibus and supplied with voltage.  
 

Insert DP slave 
 

At marked DP master, you may insert a new DP slave with .  
 

Parameterize  
DP slave  For parameterization, you click on your DP slave  in the "network" 

window. Set the parameters of the slave in the according "Parameter" 
window. 
 

 
 As soon as you assign the real station type to your slave via "Station 

type", the register "Slave parameter" shows all parameters for this slave. 
Confirm your entry with [Apply]. 
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Parameter DP slave 

Register Slave properties 
 

 

 

 
 

Name Type the name of your slave (max. 32 characters). The name serves the 
overview. There are no restrictions depending on the name but it is 
strongly recommended to use unambiguous names for function groups. 
As soon as you confirm your entry, the name is applied and shown in the 
"network" window. 
 

Profibus address Choose the Profibus address of the slave module. This value must be 
identical to the address set at the slave. Every address has to be unique 
within the network.  
 

Family This selection field assigns a function class to the DP slave. WinNCS 
takes its function classes from the GSD-files that are in the GSD directory.
 

Station model Depending on the "Family" all available station types are shown that are 
included in WinNCS via GSD-file. 
 

Error report mode According to the project engineering in the dialog window "DP master 
parameter", register "Master/Host", here the for the master system valid 
setting of the watchdog is selected per default.  
 

Watchdog Choose if the watchdog is valid for this slave or not. If a slave is not called 
within the calculated request time, it switches to secure state (all outputs 
are set to "0"). 
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Register Slave parameter 
  

Here you may parameterize the slaves directly. If there are parameters for 
a slave, these are shown and may be altered. If there are no parameters 
found, the register window remains empty. 
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Register Slave parameter values 
 

 

 
The register slave parameter serves the control of the parameters for all 
modules connected subordinated to the slave. The values are not 
changeable.  
The first 3Byte are slave parameters, the following ones are referring to 
the subordinated modules.  
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Project engineering modules 
 
Preconditions 

 
You’ve created a Profibus network with at least one DP master and one 
DP slave. 
 

Insert module 
offline 
 At marked DP slave, you insert a new module via .  

 
Parameterize 
module 

For parameterization you click on your module in the "network" window. 
Set the parameters in the "Parameter" window. 
 

 
 As soon as you assign the real module type to the symbolic module via 

"Module type", all parameters for this module are listed. Confirm your 
entry with [Apply].  
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Parameterize modules 

Register Module configuration 

 

 

 

 
 
This window allows you to set module specific parameters. Click on a 

module symbol in the "network" window or insert a new module via  to 
reach the window. 
 

 A parameter record set e.g. for the FM254 is only shown at 
parameterizable modules. For control purposes, you find the parameters 
as hex value in the register "Module parameter" 
 

Module type Starting with the chosen Profibus-DP slave, all modules that are included 
into WinNCS via a GSD-file are shown.  
 

Sign Depending on the functionality, every module has an ID, shown as hex 
value. The meaning of these IDs are defined in the Profibus-Norm. This 
field is only for information. 
 

I-Addr. or O-Addr. Set the periphery start address where the mapped module is stored. In- 
res. outputs are stored in different areas. The address requirement is 
calculated from the module data.  
 

Auto The address allocation happens automatically regarding the reserved 
addresses. 
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Map A click on [Map] opens a window that shows the assignment of the 
peripheral address area. Here you can see from which address offset on 
the in- res. output data of the selected module is stored. 
In- and output area have each one register in the window. 
 

 

3
4

1 2

5
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[1] Each one register for in- and 
output area 
[2] Legend 
[3] reserved address area 
[4] Address area of another module 
than the recent one (half-tone 
color). 
[5] Address area of the recent 
module in full-tone color 
[6] Not used addresses are shown 
in white 
 
 
 

 Under Profibus the following areas are supported :  
 

    (red) Reserved address areas. 
You may reserve up to 4 address areas for each in- and 
outputs. These areas are blocked for the automatic 
address allocation. 

    (blue) Address area occupied in the CPU by the modules 
connected via Profibus.  
 
 

Parameter area At parameterizable modules like e.g. the Motion Control FM 254, the 
lower part of the window shows a list of all parameters that are available 
for this module.  
WinNCS takes the data for this area from the GSD-file that should be up-
to-date! 
As soon as you've set and transferred the according parameters, they are 
shown in the register "Module parameter" for control purposes.  
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Register Module parameter 

 

 

 
The register module parameter is a monitor for controlling your entered 
parameters. This window allows no changes. 
 
 

 

 
 

The module parameters have the 
following structure: 
1st Byte Length 
2nd Byte plug-in location 
 
Starting with Byte 3 the other 
parameters that you've entered under 
module configuration are stored. 
 

Register Label 

 

 

 

 

 
This register allows you to print module 
labels. Except of the module name, the 
mask is editable.  
Entered labels are stored after [Apply]. 

Print label 

  

 

 
To print out the labels, you first have to 
activate the option "Label" under File > 
Print options. If you now choose File > 
Print, the labels of all modules that are 
connected to the current CPU are 
printed.  
The options "Detail view" and "Total 
network" have no influence.  
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Data transfer between WinNCS and DP master 

 
Outline 

 
You have the following options for data transfer: 
• Serial with the Green Cable via online functions 
• Transfer via a MMC memory card 
• Online transfer by means of a DP master PC plug-in card 
  
Precondition for the serial data transfer and the one via MMC is a 2bf-file 
that WinNCS creates with the export function.  
 

 

PC

DP master

DP

MMC

Green Cable

2bf-file

DP master
PC cardWinNCS

RS485RS232

MMCSip-Tool

 
Create 2bf-file • Activate the master level in the "network" window.  

• Call the context menu (right mouse button) and choose  export.  
• Type a File name and confirm your entry. 
• >> WinNCS now exports your project into a 2bf-file. 

 

     

Please don't forget to calculate the bus parameters before data transfer. 
Activate the function group "Profibus" in the "network" window. The button 
for the bus parameter calculation is in the register "Bus parameter".  
At every change of the module combination you have to recalculate the 
bus parameters. 
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Transfer serial via online functions 

 
Precondition 

 
• Your project is stored in a 2bf-file. 
• A serial connection between a COM interface of your PC and the 

Profibus interface of your DP master via the Green Cable is present. 
 

    

Important note! 
Please regard that not all DP master support the Green Cable. For more 
detailed information refer to the manual of your DP master. 
 

Approach • Start WinNCS 
• Choose the functionality "Profibus" 
• Activate the online functions via Online > Online functions res. via 

.  
• The buttons for the online functions appear as symbol bar in the lower 

part of the main window.  

• Click on  and adjust the communication parameters. Choose 
"Serial" at Medium, the number of your PC interface under Serial port 
and confirm your entry. 

• Turn off the power supply of your Profibus-DP master. 
• Push the operating mode lever at your DP master in position MR and 

turn on the power supply again. Release the operating mode lever.  
• Now your DP master can receive serial data via the Profibus interface.

• Establish a connection between PC and Profibus-DP master via . 
The communication parameters given under "Init" are used. This 
online connection is the precondition for the following functions. 

• Transfer your 2bf-file via  into your DP master. 
 

Transfer progress The transfer is monitored via a progress indicator and can be terminated 
at any time via [Stop]. 
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Import a project as 

2bf-file via  

At running online connection you can now transfer the project in the DP 

master as 2bf-file into the PC via  and import it into WinNCS via . 

 

Transfer via MMC reading device 

 
Precondition 

 
• Your project is stored as 2bf-file. 
• To transfer the project engineering into the Profibus-DP master you 

need a MMC and a MMC reading device.  
 

Approach 
 

• Copy the 2bf-file onto the MMC. 
• Rename the file into dpm.2bf 
• Turn off the power supply of the DP masters 
• Plug-in the MMC into the DP master 
• Start the MMC transfer in your DP master. For more detailed 

information please refer to the manual of your DP master. 
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Transfer via DP master PC card 
 

 
 

 
Engineer your Profibus. You can transfer your entries via the online 
functions from the PC directly into the DP master or load it from there into 
the PC.  
 

  
After a click on this button, the screen "Address parameter" appears. Here 
you adjust the addresses for the communication between the two master 
systems.  
 

 
 

Local Addr.  Profibus address of the DP master PC card.  
Remote Addr.  Profibus address of the destination system. 
Baudrate Current Baudrate of the Profibus network. 

  
Establishes a connection to Profibus. 

  
Requests the status of the master. 

   
Remote control of the master via Profibus. 

  
Transfers the data base from the master into the PC via Profibus. 

  
Transfers the data base from the PC into the master via Profibus. 
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System 200V functionality 

Overview 

 
Functionality 
System 200V 

 
With the functionality System 200V you may parameterize res. rebuild and 
documentate CPUs for STEP5 from Siemens and the according 
periphery.   
 
 

CPU Due to the project engineering, a DB1 is emulated for the CPU that can be 
exported as s5d-file. Additionally you have the option to include and 
activate a S5 symbol file from Siemens. The names of the symbol file are 
automatically used for the labels.  
 

Documentation You may also use the System 200V functionality for documentation 
purposes. For this you rebuild/clone your system and are now able to print 
labels, parameter lists etc.  
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Fast introduction System 200V functionality 

 
Outline 

 
The System 200V functionality is only available for engineering STEP5 von 
Siemens-CPUs. 
You export your project as DB1 in form of a s5d-file.    
 

Steps of project 
engineering 

• Start WinNCS 

• Select the functionality "System 200V by clicking on . 
• Create a new project with the function group "System 200V" via File > 

create/open.   
•   >> Now you reach the "Parameter" window "Function group". 
• Type a convenient name for your network under "Function group" and 

click on [Apply].  

• Add a new CPU in the "network" window via . 
• In the "Parameter" window type Name and CPU-Type and click on 

[Apply].  

• Engineer all peripheral modules via  that are connected to the 
CPU via backplane bus.  

• Via [Auto] you may start the automatic address allocation for the 
periphery and monitor it via [MAP].  

•  Depending on the used CPU-Type, you may enter settings in the 
register "System parameter" that are mapped as DB1 at export in a 
s5d-file. The manual creation of a DB1 is not longer necessary. 

•  Via the register "Process image" you organize the peripheral address 
area of your CPU by excluding special address ranges from the 
automatic address allocation. 

•  Via symbol file you may include and activate a S5 symbol file from 
Siemens at any time.  

• The symbol file is registered at the documentation (label print). 
• Activate the function group System 200V in the "network" window and 

export your project into a s5d-file. 
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Create new System 200V project  

 
Create new Profibus 
project 
 
 
 

 
Start WinNCS. 

 
Functionality 
Profibus 

 
 

Click on  to activate the functionality "System 200V". 
 

File > Project set-
up/open 

 

Create a new project with the function group "System 200V" via File > 
Project set-up/open. 
A file selection window appears where you assign a name to your project 
file.  If you type the name of an existine file, this is opened.  
The project file  under WinNCS has the extension "vpr". The last 4 opened 
project files are listed in the file menu for direct access.  
Confirm your entries to open the "network" window with concerning 
"Parameter" window. 
The "network" window monitors your new "System 200V" network. In the 
"parameter" window you may assign a symbolic name to your net. 

By click on  in the "network" window you may add further networks 
with the chosen "System 200V" functionality to your project at any time.  
 

 

 
 
Additionally to the "network" window, the "parameter" window opens. The 
"parameter" window serves the parameter setting for the elements of the 
"network" window. For example you may assign a symbolic name that is 
used to monitor the System 200V network in the "network" window. 
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Alter System 200V project and engineer CPU 

 
Preparation 

 
Load the System 200V project you want to alter res. create a new one.  
A loaded res. created project is opened in the "network" window with 
concerning "parameter" window. 
On basis of a network symbol that shows the functionality, you may add 
CPUs or modules with "System 200V" functionality and parameterize 
them in the concerning "parameter" window.  
 

Project engineering Depending on the position in the network list, the upper part of the window 
contains symbols that can be used for the construction of the network.  

Configure a CPU by clicking on . 
Switch to the "parameter" window for the CPU settings.  
 

     

Note! 
You may only return to the "network" window when you confirm your 
entries via [Apply]. When you click on [Cancel], your station is deleted res. 
your entries are. 
 

 If you now click on the station in the "Network" window, you get a list of 
network elements useable for this station.  
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Parameterization of the System 200V 

Parameter System 200V network 

Register Function group 
  

 
 
Name 

 
Here you may assign a name for your function group (max. 32 
characters). The name is for a better overview. There are no restrictions 
for the name but it is urgently advised to use unambiguous names for 
function groups.  
As soon as you [Apply] your entries, the name is taken over and shown in 
the "network" window. 
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Parameter CPU 

 

 

 
You reach the "parameter" window by clicking on a CPU in the network 
list res. create a new CPU. 
The "parameter" window contains the following registers: 
• CPU 200V (CPU type selection) 
• System parameter (Parameterization of the selected CPU) 
• Process image (Block address areas for the automatic address 

allocation) 
 

Register CPU 200V 
 

 

 

 
 

 This dialog window allows you to enter CPU specific parameters. You 
reach this window by clicking on a CPU group in the "network" window or 

add a new CPU via . 
 

Name You may assign a name for the CPU that serves a better overview. After 
[Apply], the name is shown in the "network" window. 
 

Date and time This fields serve the documentation. You can fix the time of the last 
change. 
 

CPU type Choose a CPU to parameterize from the selection list.  
Depending on the selected CPU type, the content of the register "System 
parameter" changes.  
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Register System parameter 
  

 
 
In the register System parameter you enter CPU settings that are taken 
over at export into a s5d-file as DB1.  
The manual creation of a DB1 is not longer required. 
 

Max. cycle time The max. cycle time is the maximum time a cycle may last. If this time is 
exceeded, the CPU switches to STOP. 
 

OB number 
OB interval 

These parameters allow you to activate a time organisation block (OB 10 
to OB 13) that can be cyclically called (TFB). That request interval is to 
enter into "OB-Interval". Please regard that your entry is multiplicated with 
factor 10ms (Ob-Intervall:10 is 100ms) 
 

Symbolic file Here you may choose a S5 symbol file from Siemens. As soon as you 
choose "active", the symbol comments of the symbol file are used for the 
labels. These must not be altered in WinNCS. The deactivation of the 
symbol file keeps the symbol comment but now they can be altered.  
 

DB1  
module parameters 
 

This window informs about the current DB1 module parameters. 
Deploying parameterizable modules, like e.g. analog modules, they 
appear in the display (P0x:). Additionally you may see which addresses 
are used to call the modules (UAT:). 
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Register I/O Image 
 

 

 

 
 
Via this register you organize the peripheral address area of your CPU. 
You may block addresses for the automatic address allocation and 
monitor the current address allocation via the button [Map]. 
 

Reserved I/O range You may reserve up to 4 address areas for each in- and outputs. These 
areas are protected at the automatic address allocation. 
 

Map If you click on [Map], a window is opened that shows the occupancy of the 
peripheral address area. Here you may see for example, from which 
address offset on the in- res. output data of the chosen module is stored.  
For in- and output area, the window has each one register. 
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[1] Each one register for in- and 
output area 
[2] Legend 
[3] reserved address area 
[4] Address area occupied by 
others than the chosen module 
(half-tone color). 
[5] Address area of the chosen 
module in full color 
[6] Not used address areas are 
shown in white 
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 The System 200V supports the following areas: 

 
    (red) Shows reserved address areas. 

You may reserve up to 4 address areas each for in- and 
outputs. These areas are protected at the automatic 
address allocation.  

    (blue) Address area occupied in the CPU by the modules 
connected via Profibus.  

    (green) Address area occupied by the central plugged modules. 
    (yellow) Marks the address area occupied by periphery 

integrated in the CPU.  
 

I/O CPU with  
DP slave 

At deployment of the combined CPU DP you may reserve address areas 
for the Profibus coupler. The here entered values are shown in the I/O 
map in yellow as integrated periphery (IP). 
 

 

 
 

 For the integrated Profibus coupler, the following address ranges are 
available:  
 

 In-/output channels Default start address Length 
 Inputs  from 198 max. 64 Bytes 
 Outputs  from 198 max. 64 Bytes 
    
 Control data   
 PRM (Parameter) from 230 24 Bytes (fix) 
 DIAG (Diagnosis) from 230 6 Bytes (fix) 
 STATE (Status) from 254 2 Bytes (fix) 



System 200V functionality Manual VIPA WinNCS 
 

170  HB 91E - Rev. 04/03 

Engineer modules  

 
Precondition 

 
You've created a network with at least one CPU. 
 

Insert module 
offline  
 At selected CPU you may add a new module with .  

 
Parameterize 
module 

For parameterization you click on your module in the "network" window. 
Enter the parameters in the "parameter" window. 
 

 
 When you assign the real module type to your module via "Module type", 

all parameters for this module are listed. Confirm your entry with [Apply].  
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Parameterize modules 

Register Module configuration 

  

 
 
This dialog window allows you to enter module specific parameters. To 
reach this window, click on a module symbol in the "network" window or 

insert a new module via . A parameter set e.g. for FM 254 is only 
shown for parameterizable modules. For control purposes you find the 
parameters as Hex value in the register "Module parameter". 
 

Module type WinNCS uses for the administration of the periphery a module file that is 
delivered with WinNCS. 
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Reserve  
address areas for 
Profibus master 

WinNCS gives you the opportunity to reserve addresses for a Profibus 
project. You just have to enter the 2bf-file that you've created in your 
Profibus project via Export. As soon as you click on [Apply], the addresses 
are reserved and mapped as DP addresses in the map. 
  

 
 

ID DP master Depending on the functionality, every module has a special ID, here 
shown as hex value. The meaning of this IDs is defined in the Profibus 
norm. This field has only information purpose.  
If you've selected 208-1DP00 as module type, The label DP Master 
appears. Select a 2bf-file for this module that you can search via [...]. 
 

    
 

Attention! 
The addresses of the central and the decentral periphery must not 
overlap! Please parameterize the decentral periphery first!  

I-Addr. or O-Addr. Select the peripheral start address of the System 200V module mapping. 
The address need is automatically calculated from the module data.  
 

Auto The address allocation happens automatically regarding the reserved 
addresses. 
 

Map Via [MAP] you can call a window that shows the peripheral address 
allocation. Here you may see for example, from which address offset on 
the in-/output data of the module are stored.  
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[1] For in- and output area one register each
[2] Legend 
[3] reserved address area 
[4] Address area occupied by others than 
the chosen module (half-tone color). 
[5] Address area of the chosen module in 
full color 
[6] Not used address areas are shown in 
white 
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 The System 200V supports the following areas: 
    (red) Shows reserved address areas. 

You may reserve up to 4 address areas each for in- and 
outputs. These areas are protected at the automatic 
address allocation.  

    (blue) Address area occupied in the CPU by the modules 
connected via Profibus.  

    (green) Address area occupied by the central plugged modules. 
    (yellow) Marks the address area occupied by periphery 

integrated in the CPU.  
 

Parameter area At parameterizable modules like e.g. the Motion Control FM 254, the 
lower part of the window shows a list of all parameters that are available 
for this module.  
WinNCS takes the data for this area from the GSD-file that should be up-
to-date! 
As soon as you've set and transferred the according parameters, they are 
shown in the register "Module parameter" for control purposes.  
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Register Module parameter 

 

 

 
The register module parameter is a monitor for controlling your entered 
parameters. This window allows no changes. 
 

 

 
 

The module parameters have the following 
structure: 
1st Byte Length 
2nd Byte plug-in location 
 
Starting with Byte 3 the other parameters 
that you've entered under module 
configuration are stored. 
 

Register Label 

 

 

 

 
 

 
This register allows you to print module 
labels. Except of the module name, the mask 
is editable.  
Entered labels are stored after [Apply].   

 You may label your labels automatically by including and activating a 
symbol file. As long as this is active, the label letters consisting of the 
symbol comments are not alterable. Changes take place in the symbol file.

 
Print label 

  

 

 
To print out the labels, you first have to 
activate the option "Label" under File > Print 
options. If you now choose File > Print, the 
labels of all modules that are connected to 
the current CPU are printed.  
The options "Detail view" and "Total 
network" have no influence. 

 



Manual VIPA WinNCS System 200V functionality 

HB 91E - Rev. 04/03  175 

Data transfer 

Import/Export 

 
General  

 

With  in the context menu you may export your database as file via a 
station from the network.  
Depending on the selected functionality, the export creates a file from the 
CPU/Station and module data and stores it in a format concerning to the 
hardware platform. This database can then be transferred to another 
module. 
 

Export CPU s5d-file Contains the DB1 
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Glossar 

AP 
Application protocol 
AG 
Automatisierungs-Gerät = automation device 
BCD 
Binary-Coded Decimal  
CP 
Communication Processor  (H1 and TCP/IP) 
DNS 
Domain Name System 
GSD 
Gerätestammdatei = Electronic data sheet 
HTB 
Handling block 
IP 
Internet Protocol 
IPC 
Intelligent process communication 
ISO 
International Organisation for Standardization 
LAN 
Local Area Network 
Layer 
Level in the ISO/OSI layer model (1 to 7) 
MMS 
Manufacturing Message Specification 
NAT 
Netzwerk Analyser Treiber = Network analyzing driver 
OSI 
Open Systems Interconnection 
PDU 
Process Data Unit 
QVZ 
Quittungsverzug = Acknowledgement delay 
SNMP 
Simple Network Management Protocol 
TCP 
Transport Control Protocol 
TP 
Transport protocol 
TPDU 
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Transport Protocol Data Unit 
TRADA 
Transparent data transfer 
TSAP 
Transport Service Access Point 
UDP 
User Datagram Protocol 
VDE 
Database Engine for administration of the database 
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C 
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Changes ...............................................................1 
Clock function .....................................................51 
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Clock master.......................................................51 
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CP 
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Parameter 
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Project engineering 
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H1 connections..............................................81 
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Project 
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import......................................................37 
new .........................................................37 

TCP/IP connections.......................................62 

D 
DHCP..................................................................58 
Directory structure ................................................3 
DNS 57, 59 

E 
Etherne coupler 

Project engineering 
new..............................................................120 

Ethernet address ................................................45 
Ethernet coupler ...............................................116 

Automatic address allocation.........................140 
Include GSD...................118, 137, 155, 159, 176 
Parameter ......................................................125 
Project engineering 
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Change IP circle...............................................30 
CP 
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H1 connections.......................................81 
new project .............................................37 
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Fast introduction 
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Ethernet coupler engineering ......................118 

H1 driver installation.........................................31 
IP address ..............................................131, 133 
Outline ......................................................29, 116 
Parameter ........................................................40 
Ping ..................................................................98 
Status and error message..............................110 
Symbol manager ..............................................98 
System parameter............................................88 
TRADA .............................................................67 
unspecified parameterization .....................65, 68 

Ethernet funktionality 
CP 

Project engineering 
Import function ........................................38 

Export functions ..................................................23 

F 
Fast introduction 

CP project engineering.....................................34 
Ethernet coupler engineering.........................118 
Profibus functionality ......................................143 
System 200V functionality..............................168 

Firmware update.................................................47 
CP 46 
Ethernet coupler.............................................135 

G 
Gateway..............................................................60 

H 
H1 connection.....................................................82 
H1 datagramm connection..................................91 
H1 driver installation ...........................................31 
H1 multi connection ............................................86 
H1 transport  connection.....................................82 
handling block.....................................................90 
Handling block ..................................................111 
Help system ........................................................27 

I 
I/O-Map...............................................................25 
Import functions ..................................................23 
Indicator word .......................................73, 89, 106 
Indirecte Addressing ...........................................90 
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IPC 58 

M 
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Map 25 
MAP 
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Menu bar...............................................................9 
Multi connection..................................................86 
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N 
Network window..............................................7, 20 

Symbol bar .......................................................21 

O 
Online functions ................................... 17, 96, 164 

CP 95 
Order types .........................................................62 

P 
Page view ...........................................................14 
Parameter 

CP 43 
Ethernet .........................................................40 
H1 connection................................................82 
H1 datagramm connection ............................91 
H1 multi connection .......................................86 
H1 system parameters ..................................88 
TCP connection .............................................64 

RFC 1006................................................69 
TCP Multi connection ....................................70 
TCP system parameter..................................72 
UDP connection.............................................75 
UDP multi connection ....................................79 

Ethernet coupler .............................................127 
Ethernet .......................................................125 
Modules .......................................................139 

Profibus-DP master........................................152 
Profibus network..........................................148 
Profibus-DP slave........................................156 

Modules ................................................160 
System 200V..................................................171 

CPU .....................................................172, 173 
Modules ................................................177 

Parameter window ..............................................24 
Parameter window ................................................7 
Password ............................................................49 
Ping function .......................................................27 
print labels...........................................................13 
Printer output ......................................................12 
Profibus functionality.........................................142 

Data transfer...................................................163 
DP master parameter.....................................152 
Error report mode...........................................153 
Fast introduction.............................................143 
Overview ........................................................142 
Symbolic file ...................................................154 
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Project 

Page view.........................................................14 
print ..................................................................12 
saving ...............................................................12 
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create, open ...........................................120, 169 
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Registration...........................................................5 
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Scope of delivery ................................................. 2 
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System 200V functionality................................ 167 
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Deployment CPU DP..................................... 175 
Fast introduction............................................ 168 
import............................................................. 169 
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alter................................................................ 170 

System parameter.............................................. 72 
System requirements ........................................... 2 

T 
TCP connection ........................................... 62, 64 
TCP Multi connection......................................... 70 

U 
UDP connection ................................................. 75 
UDP connection ................................................. 62 
UDP multi connection ........................................ 79 

W 
WinNCS 

Context menu .................................................. 28 
Environment ...................................................... 7 
Export functions............................................... 23 
for CPs............................................................. 29 
for Ethernet coupler....................................... 116 
for Profibus .................................................... 142 
for System 200V............................................ 167 
Help system..................................................... 27 
Import functions............................................... 23 
Include programs............................................. 15 
Installation ......................................................... 3 
Main window...................................................... 9 
Menu bar ........................................................... 9 
Network window .............................................. 20 
Online functions............................................... 17 
Page view........................................................ 14 
Parameter window........................................... 24 
Project 
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